
All trademarks, brandnames, and brands appearing herein are the property of their respective owners. 

•  Critical and expedited services
•  In stock / Ready-to-ship

•  We buy your excess, underutilized, and idle equipment
•  Full-service, independent repair center 

Accu-Sort Axiom 400

4-Laser Bar Code Reader

In Stock

Used and in Excellent Condition

Open Web Page

https://www.artisantg.com/50788-1

Artisan Scientific Corporation dba Artisan Technology Group is not an affiliate, representative, or authorized distributor for any manufacturer listed herein.

https://www.artisantg.com/50788-1/Accu-Sort-Axiom-400?pdf=50788-1
https://www.artisantg.com/50788-1?pdf=50788-1


AXIOM™ 400
Bar Code Scanning Solutions

Product Manual



 

 

AXIOM™ 400 Bar Code Scanning Solution User Manual   Revision 1.0 
 
PN 1000055015  1.0  |  CMS 04-0372-01  |  02.22.05  |  LSM 
 

Document Revision Control 

This document is under revision control in accordance with Accu-Sort’s Quality 
System. Any addenda or other documents associated with this manual are under 
separate revision controls. A revision number is changed by 0.1 whenever 
technical information is changed or added to a document. Any document version 
with a revision between 0.1 and 0.9 is automatically considered preliminary. Our 
Engineering Change Order (ECO) process is used to manage documents with a 
revision greater than 0.9.  

 

 
Copyright Information 
 
Copyright © 2003-2005 ACCU-SORT® SYSTEMS, INC. All rights reserved. 

No part of this document is to be reproduced or utilized in any form or by any 
means, electronic or mechanical, including photocopying, recording, or by an 
information storage and retrieval system without prior written consent of Accu-
Sort Systems, inc. All drawings and specifications contained in this manual are the 
property of Accu-Sort Systems, inc. and shall not be reproduced, copied or used in 
whole or in part as the basis for the sale or manufacture of products without the 
written permission. 

Accu-Sort®, DRX® and the AS logotype are registered trademarks, and Axiom™, 
Axcess™ and 1-800-BAR-CODE™ are trademarks of Accu-Sort® Systems, inc. 

All other company or product names are mentioned for purposes of identification 
only, and may be trademarks of their respective owners. 

 
Disclaimer Information 

The information contained in this manual is subject to change without notice. 
Supplemental information or documentation may be required for certain 
applications or usage. 

The examples and diagrams in this manual are included solely for illustrative 
purposes. Because of the many variables and requirements associated with any 
particular installation, Accu-Sort cannot assume responsibility or liability for 
actual use based on the examples and diagrams. 

No patent liability is assumed by Accu-Sort with respect to use of information, 
circuits, equipment, or software described in this manual. 

In no event will ACCU-SORT® SYSTEMS, INC. be responsible or liable for indirect or 
consequential damages resulting from the use or application of this equipment. 
 

Accu-Sort Systems, inc.    511 School House Rd. Telford, PA 18969    1-800-BAR-CODE™ 



AXIOM™ 400 Product Manual Contents i 
 

00b-AXIOM400-Table of Contents_R10.doc Accu-Sort Systems, inc. 

Contents 

 

Preface 
Intended Audience.................................................................................................................................. i 
Thank You.................................................................................................................................................. i 
Overview of Contents ...........................................................................................................................ii 
Other Sources of Information............................................................................................................iii 
Conventions............................................................................................................................................iii 
Customer Service ..................................................................................................................................iv 

 
1  Introduction 

Product Overview.............................................................................................................................. 1-1 
The Axiom Scan Head ...................................................................................................................... 1-3 
The Axiom Wiring Base ................................................................................................................... 1-5 
AXCESS™ Configuration Setup Software ................................................................................... 1-7 
Axiom Bar Code Scanning Solutions ........................................................................................... 1-8 
Options and Accessories ................................................................................................................. 1-8 

 
2  Safety 

Symbols................................................................................................................................................ 2-1 
General Precautions ......................................................................................................................... 2-2 
Unpacking, Mounting and Installation Recommendations .................................................. 2-2 
Compliance Requirements.............................................................................................................. 2-3 
Electrical Safety................................................................................................................................. 2-3 
Electrical Grounding Requirements ............................................................................................. 2-4 
Electrostatic Discharge.................................................................................................................... 2-4 
Basic Rules for ESD Control ........................................................................................................... 2-4 
Laser Safety ........................................................................................................................................ 2-5 
Safety Labels and Locations........................................................................................................... 2-6 

 
3  Mechanical Installation 

Preparing to Install ........................................................................................................................... 3-1 
Installation Sequence(s).................................................................................................................. 3-2 
What You Need to Know about Your Application................................................................... 3-3 
Orientation Considerations ............................................................................................................ 3-4 
Read Range ......................................................................................................................................... 3-4 
Bar Code Orientations ..................................................................................................................... 3-5 
Reader Positioning............................................................................................................................ 3-6 
Dimensions and Clearances ........................................................................................................... 3-7 
General Mounting Guidelines........................................................................................................ 3-9 
Attaching the Wiring Base............................................................................................................. 3-9 
Attaching the Universal Mounting Bracket (UMB) ...............................................................3-10 
Attaching the Axiom Power Supply to UMB...........................................................................3-11 
Attaching the X-Pattern Mounting Bracket (XMB) ..............................................................3-12 
Attaching the Axiom Power Supply to XMB ...........................................................................3-13 
Mounting the Trigger Photoeye..................................................................................................3-14 
Mounting the Tachometer............................................................................................................3-15 
Mounting the I/O Modules...........................................................................................................3-16 
Installing a Scan Head...................................................................................................................3-17 

 
 
 



ii Contents AXIOM™ 400 Product Manual 
 

Accu-Sort Systems, inc. 00b-AXIOM400-Table of Contents_R10.doc 

4  Electrical Installation 
Preparing for Electrical Installation............................................................................................. 4-1 
Installation Sequence(s).................................................................................................................. 4-2 
Wiring the Axiom.............................................................................................................................. 4-4 
Cable and Conduit Connections ................................................................................................... 4-6 
Power Requirements ........................................................................................................................ 4-7 
Power Supply Connections............................................................................................................. 4-8 
Trigger Connections........................................................................................................................4-12 
Tachometer Connections ..............................................................................................................4-13 
RS232/422 Communications Connections..............................................................................4-14 
Ethernet Communications Connections...................................................................................4-15 
I/O Module Connections ...............................................................................................................4-16 
Installing a Scan Head...................................................................................................................4-18 
Check Axiom Installation..............................................................................................................4-18 

 
5  Setup and Operations 

First-time Startup ............................................................................................................................. 5-1 
Default Parameters........................................................................................................................... 5-1 
First-time Setup ................................................................................................................................ 5-2 
Check Operations using Test Mode.............................................................................................. 5-2 
Operations Checklist ........................................................................................................................ 5-3 
Axiom Control Panel Indicators .................................................................................................... 5-4 
Checking Operations with Axcess ................................................................................................ 5-6 
Standalone Operation...................................................................................................................... 5-7 
Tracking Operation ........................................................................................................................... 5-8 
X-Scanning Operation ..................................................................................................................... 5-9 
Multiple-Reader Network Operation.........................................................................................5-10  
Scanning Array / Tunnel Operation............................................................................................5-11 

 
6  Maintenance 

Maintenance Tasks ........................................................................................................................... 6-2  
Cleaning Exit Window ..................................................................................................................... 6-3  
Cleaning Trigger Photoeye.............................................................................................................. 6-4  
Cleaning Tachometer ....................................................................................................................... 6-5  
Tighten Mounting Hardware ......................................................................................................... 6-6  
Verify Operations............................................................................................................................... 6-7 

 
7  Troubleshooting 

Test Mode............................................................................................................................................ 7-1 
Status Indicators ............................................................................................................................... 7-1 
Diagnostics.......................................................................................................................................... 7-5 
Axcess for Axiom Diagnostics ....................................................................................................... 7-5 
Troubleshooting Tables ................................................................................................................... 7-6 

 
8  Service 

Replacement Procedures................................................................................................................. 8-1 
Replacing a Scan Head.................................................................................................................... 8-2 
Replacing a Wiring Base ................................................................................................................. 8-3 
Replacing an I/O Module ................................................................................................................ 8-4 
Replacing a Power Supply .............................................................................................................. 8-5 
Replacing a Trigger Photoeye ........................................................................................................ 8-6 
Replacing a Tachometer.................................................................................................................. 8-7 

 



AXIOM™ 400 Product Manual Contents iii 
 

00b-AXIOM400-Table of Contents_R10.doc Accu-Sort Systems, inc. 

 
 
 
 

Appendices 
A  Specifications 

Technical Specifications..................................................................................................................A-1 
Power Supplies for Axiom...............................................................................................................A-2 
Output Modules.................................................................................................................................A-2 
Input Modules....................................................................................................................................A-2 
Options and Accessories .................................................................................................................A-3 
Dimensions..........................................................................................................................................A-4 
XMB Dimensions ...............................................................................................................................A-5 
Certifications......................................................................................................................................A-6 

 
B  Read Charts 

AXIOM 400 Scan Rate Explained .................................................................................................B-1  
High-Density Configurations (10 and 12 mil code)................................................................B-2 
Standard Configurations (15 and 20 mil code)........................................................................B-3 
X-Scanning Applications: High-Density Configurations (10 and 12 mil code) ..............B-4 
X-Scanning Applications: Standard Configurations (15 and 20 mil code) ......................B-5 

 
C  Glossary 

Glossary of Terms..............................................................................................................................C-1 
 

D  Interconnect Drawings 
Controller/Client with Tachometer (107480) ..........................................................................D-3 
Controller/Client/Client with Tachometer (107481)...............................................................D-5 
Start/End Trigger Photoeyes (107482)........................................................................................D-7 
Stack Light with Internal Relays (107483)................................................................................D-9 

 
 

Index 
 



iv Contents AXIOM™ 400 Product Manual 
 

Accu-Sort Systems, inc. 00b-AXIOM400-Table of Contents_R10.doc 

Notes: 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 



AXIOM™ 400 Product Manual Preface i 
  

00c-AXIOM400-Preface_R10.doc Accu-Sort Systems, inc. 

1 Preface 
Welcome to release 1.0 of the AXIOM™ 400 Product Manual from Accu-Sort 
Systems, inc. This Product manual includes the information you need to 
effectively integrate the Axiom Bar Code Scanning Solution with your 
application. It contains detailed information about the following: 

 Product features, capabilities, specifications and accessories 

 Safety information 

 Installation guidelines and procedures  

 Configuring the Axiom for your application  

 Maintenance and Troubleshooting 

This preface explains how this Product manual is organized and introduces 
other sources of information that you will find useful. 

 

Intended Audience 

You should have a basic understanding of bar code scanning. Equipment 
installers must be familiar with standard wiring techniques and terminology. 
Because the Axcess software runs in the Microsoft® Windows® environment, 
you should know how to use a mouse, choose commands, and work with 
windows and dialog boxes. 

This manual contains some terms that may be unfamiliar.  Use the glossary at 
the back of this manual for assistance. 

 

Thank You 

Thank you for using an Axiom bar code scanning solution and this manual.  

We value your comments and feedback. Feel free to let us know what you like 
or dislike about Axiom (or this manual) by e-mailing us at info@accusort.com.  

You can also mail your comments to our corporate headquarters address or call 
us directly at (215) 723-0981 or 1-800-BAR-CODE™. 
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Overview of Contents 

This manual includes the following chapters: 

 Chapter 1, “Introduction,” introduces you to the advanced capabilities 
that make the Axiom an impressive performer in the laser bar code 
scanning market. It covers hardware, software, and other features common 
to all Axiom™ bar code scanning solutions and concludes with an overview 
of typical Axiom applications. 

 Chapter 2, “Safety,” addresses the necessary precautions you must 
observe while installing and operating the Axiom. These include: laser 
safety, electrostatic discharge control, grounding, and compliance. 

 Chapter 3, “Mechanical Installation,” discusses key factors that affect 
reader performance. As an aid to installers, it provides both an installation 
sequence checklist and easy-to-follow, step-by-step mounting procedures 
to complete the mechanical installation of single and multi-unit solutions. 

 Chapter 4, “Electrical Installation,” defines how to use the tables on the 
Axiom wiring base and the interconnect diagrams found in Appendix D to 
complete the electrical installation of your reader. 

 Chapter 5, “Setup and Operation,” contains basic instructions for 
completing the initial setup configuration of your Axiom reader(s), trigger, 
tachometer, and communications parameters. It includes cross references 
to the Axcess Setup Software Manual. This chapter also outlines how the 
Axiom functions during normal operation.  

 Chapter 6, “Maintenance,” defines recommended cleaning procedures and 
equipment checks to assure the Axiom provides peak performance.  

 Chapter 7, “Troubleshooting,” covers the Axiom’s advanced diagnostics as 
well as troubleshooting tables.  

 Chapter 8, “Service,” provides instructions for the removal and 
replacement of key “field-replaceable” (FRU) components. 

 Appendix A, “Specifications,” contains a detailed listing of all Axiom bar 
code scanning solution specifications, read charts, certifications, options 
and accessories. 

 Appendix B, “Read Charts,” provides Axiom standard and high-density 
read charts for both single readers and dual readers used in X-scanning 
applications. 

 Appendix C, “Glossary,” contains a comprehensive listing of terms that are 
relevant to bar code scanning in general and the Axiom in particular. 

 Appendix D, “Interconnect Drawings,” provides schematic diagrams for 
wiring your Axiom for various applications. These diagrams are cross 
referenced in Chapter 4. 
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This Product manual is available online. 

The Axiom 400 Product Manual is available online in Adobe Acrobat PDF 
format. The paper and online versions of this manual have identical content; 
use whichever format is most convenient. 

The AXIOM 400 Product Documentation CD contains PDF versions of each 
item in the Axiom documentation set. You can search for information, read it 
on–screen, and print individual pages, sections, or entire publications by using 
this CD. When you print from Adobe Acrobat, the resulting printouts look just 
like pages from an Accu-Sort hardcopy manual. We supply this CD with every 
reader shipment. 
 

 NOTE: There may be additional material that was not available when this 
Product manual was printed. To learn if there is a documentation update for 
this product, go to our web site’s downloads page at www.accusort.com. 

 

Other Sources of Information 

You can choose from many information sources, including documentation, 
training, and support services, to increase your knowledge and understanding 
of the Axiom bar code scanning solutions. If this manual refers you to other 
documentation, use only the latest versions unless otherwise specified. 

 

Conventions 

 WARNINGS or CAUTIONS: This symbol identifies a hazard or procedure that, 
if incorrectly performed, could cause personal injury or result in equipment 
damage. It is also used to bring the user’s attention to details that are 
considered IMPORTANT. 

 HIGH VOLTAGE CAUTION: This symbol alerts the user they are about to 
perform an action involving, either a dangerous level of voltage, or to warn 
against an action that could result in damage to devices or electrical shock. 

 

LASER CAUTION: This symbol alerts the user they are about to perform an 
action involving possible exposure to laser light radiation. 

 ESD CAUTION: This symbol identifies a procedure that requires you take 
measures to prevent Electrostatic Discharge (ESD) e.g., use an ESD wrist strap. 
Circuit boards are most at risk. Please follow ESD procedures. 

 USEFUL TIPS or NOTES: This symbol draws attention to details or procedures 
that may be useful in improving, maintaining, or enhancing the performance 
of the hardware or software being discussed. 
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Customer Service 

Training 

Accu-Sort Systems offers a complete set of training courses to help you and your staff 
master Axiom bar code scanning solutions. We can help you develop a training plan 
that provides thorough training for both your project team and your end users. We will 
work with you to organize courses appropriate to your job or area of responsibility. 
Training professionals can show you how to plan your training throughout the 
implementation process so that the right amount of information is delivered to key 
people when they need it the most. You can attend courses at our training center, or 
you can arrange for our trainers to teach at your facility. In addition, we can tailor 
standard courses or develop custom courses to meet your needs. 

Support 

From on–site support to central support, our team of experienced professionals 
provides the help and information you need to keep your Axiom working for you. This 
team includes your Account Manager and Accu-Sort’s large staff of support specialists 
with expertise in your business area and managing your hardware and software 
environment. 

 NOTE: If you have any problems or questions that require Accu-Sort's help, direct 
your calls to Customer Service at (215) 723-0981 or 1-800-BAR-CODE™. 

 
To ensure Accu-Sort's response is prompt and accurate, please have the following 
information ready when calling Customer Service: 

 Product Serial Number (located on Axiom Scan Heads and Power Supplies) 

 Product Type 

 Detailed description of the question or problem 

 Customer contact name and phone number 

 
Product Type Serial Number 
Axiom 400  
  
  
  

 
Axiom400 Serial Tag 

Serial Number Breakdown 

The WWXXXXXX fields are also bar coded with a Code 128 type bar code on the 
serial tag. 

WW Two digit year of manufacture 
XXXXXX Six digit sequential build number 

Suffix Optional suffix(es) that reflect actual catalog options for off-the shelf 
units. At least 6 digits can be placed on the tag. If "Z" is part of the 
suffix, this indicates a custom unit requiring an engineering folder. 
Suffix could be used for special designations 
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1 Introduction 
 

This section presents a detailed description of the Axiom laser bar code reader. 
It begins with a product overview. The Axiom features and its’ two main 
components, the wiring base and the scan head, are described in detail.  

 Product Overview 
 Wiring Base 
 Scan Head 
 Axcess Setup Software 
 Application Solutions 

 Ordering Options and Accessories 

 

Product Overview 

The Axiom line of laser bar code readers was designed with industrial and 
manufacturing applications in mind. The Axiom offers high-speed scanning (up 
to 1400 scans per second) and high reliability, including a rugged IP65 rated 
industrial enclosure. Its large depth of field provides accurate bar code reading 
at distances up to 72 inches.  

Every Axiom includes a universal wiring base and a plug-in scan head.  The 
scan head is available in standard and high-density versions for high-speed 
scanning in fast moving applications. 

 
Figure 1-1:  Accu-Sort Axiom with Wiring Base (bottom)  

and Scan Head (top) 
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Though technologically advanced, the Axiom is designed for easy setup and 
operation.  

Axcess Setup software for the Axiom line of Accu-Sort bar code readers, 
provides a familiar Windows®-based user interface. Using the Axcess Wizard or 
the Axcess Explorer, you can configure your Axiom readers without the need 
for onsite service.  

Simply connect to your reader via the setup cable or the on-board Ethernet 
connection. Specify valid bar code types, groups, and patterns. Pad or strip 
characters from the decoded string. Define your I/O—including built-in trigger 
and tachometer signals and up to four solid state relays. When complete, 
download your application settings to the Axiom and you’re ready to go. 

These features, along with comprehensive real-time performance monitoring, 
make the Axiom the leading bar code scanning solution in its class. 
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The Axiom Scan Head 

The Axiom scan head scans package labels and decodes bar code symbols.  The 
integral DRX decoder logic decodes the most common bar code symbologies.  
The scan and decode functions are configured using the Axcess configuration 
software on a personal computer. See Chapter 5, Setup and Operations. 

The Axiom offers unparalleled read rate performance: 

 No focusing or distance measurement required.  The Axiom uses 4 lasers 
that are always scanning using a combination of alternating scans and 2 
sensors.  This creates 4 read zones and eliminates the need for distance 
measurement and focusing.  Focusing or switching from one laser to the 
next can result in lost parcels and lower read rates. 

 Continuous scanning over 4 read zones out to 72 inches.  Bar code 
labels on parcels of differing heights that are side by side on the transport 
will be read.  

 Largest read range in class. The Axiom can read over a 72-inch range. 

 No weak transition between read zones.  Two lasers are always scanning 
over the boundaries between read zones to ensure that no labels are 
missed, regardless of the distance from the box to the reader. 

 Improved performance on poor quality/contrast labels. Two lasers can be 
configured to read in the same zone, each focused differently, to enable 
the Axiom to read poorly printed and low contrast bar codes that other 
readers can’t read. 

 1400 scans per second. The highest scan rate in class, ensures the highest 
possible read rate on good and poor quality even at high transport speeds. 

The Axiom makes diagnostics and service easy. 

 Scan head module is hot-swappable. Easily change or replace an Axiom 
scan head from a wiring base without the need to disconnect the unit from 
its power source. 

 LEDs indicate signal strength. LEDs can be used to determine how well 
the Axiom is reading bar codes. See Chapter 5, Setup and Operations. 

 User self test mode helps in diagnostic mode. Used in conjunction with 
the signal strength LEDs, the self-test mode enables the user to quickly 
determine if one of the four lasers is faulty.  

Scan Head
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Bar Code Capabilities 

The Axiom is designed to decode the following bar code types: 

 Interleaved 2 of 5 
 Code 128 
 Code 39 
 Code 93  
 Codabar (including Codabar NSS) 
 UPC/EAN (including 2 and 5 character extensions with the ability to 

specify the character used to separate the code from the extension) 

For each bar code type, the quantity of bar codes to be read can be specified. In 
addition, the user can specify conditions for NO-READ and/or MULTIPLE BAR 
CODES and assign bar codes to be transmitted together as SETS. 

The Axiom decodes bar codes between 1 and 50 characters in length. Also, it 
supports up to ten different bar code definitions and supports a maximum of 
20 different bar codes within a single “trigger.” 

If you want to check your understanding of basic bar code scanning concepts, go 
to the Accu-Sort Internet website at http://www.accusort.com/ to view our Bar 
Code Basics training course. 
 

 

DRX® 

The Axiom uses Accu-Sort Systems’ patented DRX decoding logic for decoding 
bar code data. DRX technology uses partial scans to reconstruct bar codes with 
100% accuracy. DRX® enables low-aspect-ratio bar codes to be decoded, and 
improves read rates on damaged and poorly printed codes. 
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The Axiom Wiring Base 

All wiring connections to the Axiom are made via the wiring base. Terminal 
blocks in the Axiom wiring base allow you to wire up easily using common 
electrician tools—no soldering required. An insulation flap covers the terminal 
blocks and provides a ready reference for all internal connections. There are 
four conduit openings for running wires into the base. 

The wiring base includes the following:  

 Power supply input/output, 12-30V (2): The Axiom is easily wired into a 
24VDC power supply source. Power output is provided to facilitate daisy-
chaining up to three Axioms to a shared power source. These connections 
include LEDs to indicate power polarity or fault conditions. Power supplies 
are also available from Accu-Sort. When using Accu-Sort power supplies, 
each Axiom uses its own supply. 

 Dedicated trigger input (1):  This terminal block connects the contacts of 
a sensor that detects the presence of a package in the Axiom’s scanning 
area. The trigger can be either an electronic (current sourcing or sinking) or 
a hard contact type device. Most applications use a photo-reflective 
sensor. The trigger signal starts and stops decoding and determines when 
messages are sent or when outputs are energized. 

The Axiom supports three trigger modes: hardware, software and 
continuous. The software supports receipt of user specified start-of-trigger 
and end-of-trigger messages over a "host" network link or a serial port, 
which is configured for the host communication. 

 Dedicated tachometer input (1): This terminal block connects with a 
hardware tachometer, which enables the Axiom to monitor belt speed (or 
other method of product conveyance). Axiom may also be set up for a 
computed or user-specified tachometer. 

 I/O relay sockets, inputs/outputs (4): Four sets of terminal blocks for 
connecting the optional input or output modules. Four sockets support any 
input and output module combination.  For example: An output module 
could be used to activate a diverter/sorter and an input module connected 
to a photoeye could acknowledge that the diverting was accomplished. 
(See specifications in Appendix A.) 

 Serial communication, RS232/422 (1): An RS232/422 port allows point-
to-point communications with a single device or multiple reader network. 

 Ethernet port (1):  The Axiom is the only laser reader in its class to offer 
integrated Ethernet TCP/IP. Up to four Axioms can be connected on an 
Ethernet network.  Together, these readers can: 

 Work in a coordinated mode to read multiple bar code symbols on 
different sides of the same package. 

 Combine data from several readers through a single reader that 
communicates the data to a host. 

 Pass input and output status information between readers. 

 Communicate, real-time, with a host device. 

 

 Wiring Base 
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 Remote setup and monitoring of reader operations from a host device 
instead of using a direct-connection between a PC and Axiom (using 
the programming cable). 

 Parameter Storage Module (1): The parameter storage module is an 
EEPROM (Electronically Erasable Programmable Read-Only Memory) chip 
that stores all of the setup and configuration information for an individual 
Axiom reader.  By using a parameter storage module in both the wiring 
base and scan head of an Axiom, either component can easily be swapped. 
Configuration settings can be downloaded from paired modules to 
eliminate the need to run through the standard set up and configuration. 

 Dedicated external setup port (1): The setup port, located on the front of 
the wiring base, allows a personal computer running the Axcess Setup 
Software for the Axiom Reader to download a configuration to one or more 
readers. The setup port is for temporary use during configuration transfers 
and system setup. (See Chapter 5, Setup and Operations.) 

 40-pin wiring base connector (1): The 40-pin connector on the bottom of 
the scan head plugs into this connector. All power and communications 
with the scan head occurs through this connector. 

 Threaded conduit openings (4): All permanent connections (i.e., power, 
trigger, tachometer, and communications) are made to the wiring base, 
using conduit or cable, through these openings. 
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AXCESS™ Configuration Setup Software 

The Axcess Setup Software, a Windows®-based software package, lets you 
configure an Axiom through a series of intuitive, user-friendly menus, tools and 
dialog boxes.  Context sensitive help is available to assist with use of the 
software. 

 

 
Figure 1-2:  Accu-Sort Axcess Setup Software 

 

All Axiom functions are selected from the standard menu bar, Axcess Explorer, 
or the Axcess Wizard, providing multiple access points for all setup 
parameters.  

With the Axcess Setup Software, you can: 

 Integrate Axiom to your system and application without custom software. 

 Modify the Axiom output messages to accommodate your system needs. 

 Add or modify the bar code symbologies to be read by Axiom. 

 Define up to four (4) relay input/outputs. 

 Monitor Axiom performance using various diagnostic tools.  

 

You can easily configure your Axiom reader by using the Axcess Setup 
Software (PN 1000057488), a PC, and the setup programming cable (PN 
1000007308). Setup can also be achieved on a network via communications 
with the Axiom through its’ Ethernet port. One software package and one setup 
cable are required per installation. 
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Axiom Bar Code Scanning Solutions  

Axiom’s flexibility allows you to configure it for a variety of applications.  

 Standalone – A single Axiom scanning bar codes located on the same side 
of every package passing the scanning area. 

 Standalone with Tracking – Similar in function to a standalone 
application, only a tachometer is used for tracking purposes.  

 X-Scanning – Two Axiom readers and the X-mounting bracket provide an 
x-scanning pattern for reading bar codes in various orientations. 

 Multiple-reader network – A single Axiom is configured as a “controller”. 
By doing this, the Axiom “controller” can gather data from other Axioms 
(configured as “clients”) over an Ethernet network. The Axiom then 
transfers the collected data to a host via the RS232 or network link. 

 Scanning Array / Tunnel – Two multi-reader networks are mounted to 
“blanket” several sides of an application’s scanning area to assure that bar 
codes appearing on various package sides will not make it through the 
array without being scanned and decoded. Scanning array mounting 
structures can be custom-engineered to fit your application requirements 
for up to six-sides. 

 

Options and Accessories 

To order options and accessories for your Axiom Bar Code Scanning Solution, 
reference the part numbers provided in Appendix A. Contact your sales 
representative for assistance in determining which options and accessories will 
be applicable to your application. 

If you know which items are needed, contact Accu-Sort’s Customer Service 
Department (ask for the Spare Parts Coordinator) between 8 AM and 4:30PM 
(EST) Monday through Friday at 1-800-BAR-CODE (Fax: 215-723-1515).  
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2 Safety

Please follow the safety precautions and warnings found in this manual
when installing, setting up, operating, maintaining, troubleshooting or
replacing any Accu-Sort products, parts, or related equipment. Following
these precautions will prevent personal injury or damage to the unit.
Failure to follow these precautions may also void your warranty.

This section provides important information regarding safety and your
Axiom, especially involving issues regarding:

§ General Precautions during Mounting and Installation

§ Compliance Requirements

§ Electrical Safety

§ Electrical Grounding Requirements

§ Electrostatic Discharge Precautions and Control

§ Laser Safety

NOTE: Contact Accu-Sort at 1-800-BAR-CODE™ if you need more
information.

Symbols

Throughout this manual, special safety alerts are indicated by the following
symbols:

WARNINGS or CAUTIONS: This symbol identifies a hazard or procedure
that, if incorrectly performed, could cause personal injury or result in
equipment damage.

HIGH VOLTAGE CAUTION: This symbol alerts the user they are about to
perform an action involving, either a dangerous level of voltage, or to warn
against an action that could result in damage to devices or electrical
shock.

LASER CAUTION: This symbol alerts the user they are about to perform an
action involving possible exposure to laser light radiation.

ESD CAUTION: This symbol identifies a procedure that requires you take
measures to prevent Electrostatic Discharge (ESD) e.g., use an ESD wrist
strap. Circuit boards are most at risk. Please follow ESD procedures.

Alerts help you to:

§ Identify a hazard and its consequences

§ Avoid a hazard by taking adequate safety precautions

§ Get the most out of your bar code solution
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General Precautions

Installation and Service by Qualified Service Technician Only

WARNING: All procedures involving exposure to the inside of the Axiom
wiring base must be performed by a trained technician because of possible
exposure to high voltage. There are no user-serviceable parts inside. Do
not attempt to open the unit or perform any installation/service
procedures unless you are a trained technician!

Refer all servicing and advanced troubleshooting to a qualified service
technician. Technical training is available from Accu-Sort Systems.

Furthermore, even trained technicians should always reference the specific
product documentation for more detailed service procedures that may not
be described in the AXIOM 400 Product Manual.

Unpacking, Mounting and Installation Recommendations

CAUTION: Firmly fasten mounting structures in place before installing the
equipment to any mounting structure.  Avoid using freestanding mounting
structures. If your application requires a freestanding mounting structure,
avoid making the structure top-heavy.

§ Follow all procedures regarding electrical safety, laser safety, and
electrostatic discharge safety (ESD) as outlined in this manual.

§ Save all packing material in case you have to transport your readers.

§ Use steel or aluminum as a mounting structure. An Accu-Sort mounting
structure is recommended for optimum system performance.

§ Check mounting hardware periodically for tightness and stability.

§ Do not use sheet rock, plaster board, wood, or other unstable mounting
surfaces.

§ Do not use mounting surfaces that are subject to high vibrations.

§ Do not create any obstructions of airflow around the modules. Keep the
area around the modules clean to provide for cooling. (Refer to specific
product manuals for minimum clearances.)

§ Avoid dropping the readers during unpacking and installation.

§ Do not touch the window glass of the scan head.
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Compliance Requirements

FCC NOTICE: The Axiom has been tested and found to comply with the limits
for a Class A digital device, pursuant to Title 47, Part 15 of the FCC Rules.
These limits are designed to provide a reasonable protection against harmful
interference when the equipment is operated in a commercial environment.
This equipment generates, uses, and can radiate radio frequency energy and, if
not installed and used in accordance with the instruction manuals, may cause
harmful interference to radio communications. Operation of this equipment in
a residential area is likely to cause harmful interference in which case the
user will be required to correct the interference at his own expense.

WARNING: These are Class A products. In a domestic environment, these
products can cause radio interference, in which case the user may be
required to take adequate measures. (Ref. CISPR 22 = EN 55 022:1995.)

IMPORTANT: Follow the guidelines below to maintain Electromagnetic
Compatibility (EMC) Compliance:

§ Interconnecting cables must be twisted pair cables.

§ All shielded I/O cables shall have the shield terminated to the chassis.

§ NOTE: DRAIN WIRE SHIELDING IS NOT ADEQUATE.

§ Do not remove the shielding covers.

§ Refer to the details on making custom cables as provided in the specific
technical manual for the component.

Electrical Safety

Axiom must be installed in accordance with Canadian Electrical Code, Part I,
CSA C22.1; CSA C22.2 No. 0; and the National Electrical Code, NFPA 70.  For
complete requirements, National Electrical Code, ANSI/NFPA 70, Canadian
Electrical Code, Part I, C22.1, or other national standard must be consulted.

§ For PERMANENTLY CONNECTED EQUIPMENT/RACK MOUNTED,
incorporate a readily accessible disconnect device in the fixed wiring.

§ For PLUGGABLE EQUIPMENT/RACK MOUNTED, install the socket-
outlet near the equipment so it is easily accessible.

§ Make sure that all personnel who work with the equipment know where
the disconnect switches or circuit breakers are located.

§ Before performing any type of maintenance, turn off power to the unit
and disconnect the power cord.

§ Be certain your hands and the floor of your work area are dry before
touching electrical equipment or connecting cords.

§ Routinely check all power cords, plugs, wiring, and cable connections for
any signs of exposed wire or deteriorating insulation. If you notice any
damage, make arrangements with service personnel to repair or replace
the damaged item immediately.
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Electrical Grounding Requirements

Before applying power to any device, ALL components MUST be electrically
grounded. Follow these precautions:

§ Ensure all AC power outlets have a properly grounded receptacle.

§ ALL components MUST be properly cabled and grounded with three-
conductor AC power cords.

§ Use the correct power cord for your country.

§ Reference specific grounding instructions for each component.

§ Do not use a two-prong adapter.

§ Do not cut/remove the round grounding prong from any plug.

§ Do not use an extension cord to defeat any ground.

Electrostatic Discharge

ESD CAUTION: Measures must be taken to prevent Electrostatic Discharge
(ESD) at all times when handling any product, equipment, unit or part (e.g.
use a grounded ESD wrist strap). It should be noted that circuit boards are
at greatest risk to damage from ESD. Please follow standard ESD
precautions!

Electrostatic discharge (ESD), the transfer of static electricity from one
object to another, is an often-unnoticeable hazard to electronic
components. Boards and other devices with integrated circuits are
particularly sensitive to ESD damage. Product failures may not occur until
days or weeks after the component was damaged.

Static damage to units can take the form of upset failures or catastrophic
failures (direct and latent).

An upset failure occurs when an electrostatic discharge is not significant
enough to cause total failure, but may result in intermittent gate leakage,
causing loss of software or incorrect storage of information.

Direct catastrophic failures occur when a unit is damaged to the point
where it is permanently damaged.

Basic Rules for ESD Control

Below are some keys to effectively control unnecessary ESD damage when
working with ESD-sensitive devices:

§ Define an ESD protective area and work on the ESD-sensitive devices in
this area only.

§ Define static sensitivity of devices to be handled in ESD protective area.
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§ Establish suitable static control program that limits static generation to
less than the damage threshold of the most sensitive device in the
environment, and provides a safe, defined path for static charge
dissipation.

§ Prevent contamination of the protective area by unnecessary non-static
controlled materials.

§ Audit the ESD protective area regularly to ensure that static control is
maintained. Document the findings for future reference.

§ Refer to the specific electrostatic discharge precautions for each
component.

Laser Safety

The AXIOM 400 uses visible laser diodes and emits a “moving” red beam. Do
not stare into the Axiom’s exit window at the laser light source. Avoid
direct eye exposure. The laser light level does not constitute a health
hazard, however staring at the laser light for prolonged periods could result
in eye damage.

The  following WARNING is molded into the Axiom’s exit window frame:
AVOID EXPOSURE – LASER LIGHT EMITTED FROM THIS APERTURE

Figure 2-1: Warning on Axiom Laser Exit Window to Avoid Exposure

WARNING: Use of controls, adjustments, or procedures other than those
specified in this document may result in hazardous laser light exposure.
The AXIOM 400 is rated as a Class 3R Laser Product by the International
Electrotechnical Commission. Compliances are as follows:  Class 3R Laser
Product (IEC-60825-1), 1993+A1: 1997+A2: 2001, Class II Laser Product
(21CFR1040) <5.0 mW peak at 630-700nM).
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Safety Labels and Locations

Refer to the following figures for specific label locations and warnings.
When operating, repairing, or replacing an Axiom, note all label content on
the unit. These labels provide special precautions for operation, usage
specifications, product identification, and service information.

Figure 2-2: Label Placement Axiom Scan Head

Figure 2-3: Label Placement Axiom Wiring Base

WARNING: The following is molded into the Axiom’s exit window frame:
AVOID EXPOSURE – LASER LIGHT EMITTED FROM THIS APERTURE.
(See Figure 2.1.)
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3   Mechanical Installation 
 

Before you begin your installation, become familiar with the information in 
this chapter. It defines, step-by-step, a typical Axiom installation, and 
highlights important details that may affect how the Axiom should be 
mounted, wired, and configured for optimum performance in your application. 
Be sure to consider the various factors that affect how the Axiom must be 
mounted with respect to the scanning area. Typical solutions that maximize 
the Axiom’s capabilities are highlighted.  

 

 IMPORTANT: The Axiom is an electronic microprocessor-based unit.  To 
prevent personal injury or damage to the unit (caused by electrostatic 
discharge (ESD)), please follow the safety precautions and warnings found in 
Chapter 2. Failure to follow these precautions may void your warranty. 

 

Preparing to Install 

Before mounting any components, please do the following: 

 Read all instructions before beginning your installation.  

 Define and confirm the accuracy of your application’s requirements.  
(See What You Need to Know about Your Application, page 3-3.) 

 Review all installation-specific drawings.  

 Review and plan the mechanical installation of all devices used in your 
application. Be sure to allow adequate clearance for maintenance. 

 Review and plan the power requirements for your application. 

 Check the contents of the shipping cartons against the packing list.  

 Record all product serial numbers on page vi. 

 Install the Axcess setup software on your PC. (See Chapter 5.) 

 

 IMPORTANT: The Axiom packaging is designed to protect the unit(s) during 
shipment. Do not throw it away. Save all packing material in case you need to 
transport your unit(s). The scan head and wiring base are shipped in separate 
packages. 
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Installation Sequence(s) 

 USEFUL TIP: Everything should be MECHANICALLY INSTALLED before 
performing any ELECTRICAL INSTALLATION. Reference Chapter 4 for 
electrical installation details. 

 

Installing a Single Unit 
To install a single unit, follow this sequence of steps: 

 Complete mechanical installation. 

 Review the details of your application’s requirements. 

 Determine and mark the reader mounting location.  

 Erect mounting frame or other supporting structures. 

 Attach the Universal Mounting Bracket (UMB) or X-Scanning 
Mounting Bracket (XMB) to the frame. (UMB, XMB, and mounting 
frame options are available from Accu-Sort.) 

 Mount the wiring base to the UMB, XMB, or frame. 

 Mount the Accu-Sort power supply to the UMB or XMB (optional). 

 Mount trigger (optional). (See page 3-14.) 

 Mount tachometer (optional). (See page 3-15.) 

 Mount I/O modules (optional). (See page 3-16.) 

 Complete electrical installation. 

 See Chapter 4. 

 NOTE: To reduce the possibility of damage to the scan head, install it after 
the wiring base is mounted, wired, and all wiring is checked for accuracy. Be 
sure to perform the polarity check before attaching the scan head. 

 Setup your Axiom.  

 See Chapter 5. 

 Check operations.  

 See Chapter 5. 

 
Installing multiple units 
To mechanically install multiple units, follow the same sequence of steps, per 
Axiom reader, as defined in Installing a Single Unit. Your application will define 
how the mounting requirements vary for each reader.  

Multiple-reader networks may require a different approach to physical location 
of the power source, trigger photoeye, and tachometer since they are most 
likely being shared by the group of readers.  
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What You Need to Know about Your Application 

To assure you get optimal performance out of your Axiom Bar Code Scanning 
Solution, it must be installed to meet the complete needs of your application. 
Therefore, take the time to know the details of your application. The better you 
know your application, the easier it is to apply the Axiom’s capabilities to meet 
your application’s requirements. 

Below is what you will need to know before you can begin installation: 

 Bar Code Specifications: Symbologies, Location, and Orientation 

 What bar code symbologies will be used in your application? 

 What are the code sizes (min/max bar), number of characters, etc.?  

 Where are bar codes located on the products?  

 How are bar codes oriented: Ladder, picket fence, omni-directional? 

 How much does bar code placement on product vary? 

 How many bar codes are on each product? 

 How many of these codes are to be decoded? 

 Which sides of the product will need to be scanned (e.g., top, left/right 
side, bottom, front, back, all)? 

 Conveyor Specifications 

 Conveyor type: Belt, roller, tilt tray, cross belt, other? 

 What is the conveyor width?  

 What is the conveyor speed? Does it vary or is it constant? 

 Where is the scanning area to be located on your conveyor? 

 Product Specifications  

 How many different product sizes will be scanned?  Product sizes? 

 Are products justified: toward/away from reader, centered, or variable? 

 How many sides of the products will need to be scanned? 

 Application Specifications 

 How many Axiom readers will your application need based on the 
scanning area coverage required?  

 What is the read range for each Axiom? What are the near/far 
distances, and overall depth of field required? 

 What will be done with the decoded bar code information? How will 
this information be used in your application? 

 What are your communication requirements? 

While it isn’t possible to cover all application configurations, the next several 
pages provide the basics you need to mechanically install your Axiom Bar Code 
Scanning Solution. If you need additional assistance, feel free to contact your 
sales representative or customer service. 



3-4 Mechanical Installation AXIOM™ 400 Product Manual 
 

Accu-Sort Systems, inc. 03-AXIOM400-Mechanical_Installation_R10.doc 

Orientation Considerations 

Consider the important factors that affect how the Axiom reader is oriented in 
respect to the bar coded packages (products) and their method of conveyance. 

Mounting the Axiom for optimum performance depends on these factors: 

 Read Range defining the distance (and variations) between the reader 
and packages, including the near/far distances, and overall depth of field 

 Bar Code Orientation on products (ladder or picket fence) as well as the 
angle in which codes will appear (skew, pitch and tilt) 

 Reader Positioning for type of scanning required to accommodate picket 
fence or ladder bar code orientation (yaw, pitch and roll angles) 
 

Read Range 

The Axiom must be positioned in the scanning area to accommodate reading 
products over a read range specific to your application. Use the following 
diagram to determine the near/optimum/far read distances. These dimensions 
result in the overall depth of field your application requires. 

 

 
 

Figure 3-1: Determining Read Range 
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Bar Code Orientations 

Picket Fence or Ladder Orientation  Bar code placement usually 
determines the Axiom’s positioning. The Axiom can be mounted to read codes 
in either a ladder or picket fence orientation.    

 

Figure 3-2: Picket Fence and Ladder Orientation Illustrated 
 

Bar Code Skew, Pitch and Tilt   These angles affect bar code readability.  
Bar codes pitched or skewed up to 45 degrees are still readable.  Although 
some skew may occur, it should not exceed 45 degrees. 

 

 
 

Figure 3-3: Bar Code Tilt, Pitch and Skew Illustrated 
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Reader Positioning 

 IMPORTANT: The Axiom is able to decode bar codes at a variety of angles; 
however significant angular distortion may degrade reading performance.  
When positioning the reader, remember that the scan beam exits the scan 
window parallel to the wiring base. (See Figure 3-4.) 

 When mounting the Axiom, take into consideration your application’s 
bar code orientation.  

 Mount the reader so that the scan beam is nearly perpendicular to the 
bars of the symbol and crosses every element and quite zone.   

 Figure 3-4 represents the Axiom’s range of motion when the Universal 
Mounting Bracket (UMB, PN 0105307002) is used. 
 

 
 

Figure 3-4: Axiom’s Range of Motion with UMB 
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Dimensions and Clearances 

The figures that follow provide the overall dimensions of the Axiom when the 
Universal Mounting Bracket (UMB) is used.  

See Appendix A for Axiom dimensions without the Universal Mounting Bracket 
(UMB) or when using the X-Pattern Mounting Bracket (XMB). 

The reader is a sealed, unventilated unit. No specific clearance is required for 
the purpose of cooling. However, ease-of-access should be considered when 
locating the mounting position.  

 

 USEFUL TIP: For installation, maintenance and service reasons, 
approximately 8-12 inches of clearance is recommended. 

 

 
Figure 3-5: Axiom Dimensions – Top View 
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Figure 3-6: Axiom Dimensions – Left Side View 

 

 

 
Figure 3-7: Axiom Dimensions – Front View 
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General Mounting Guidelines 

As you plan and install your Axiom bar code solution application, be sure to 
keep the following mounting guidelines in mind: 

 Determine the proper orientation and position of the reader. 

 Leave adequate clearances (approximately 8-12 inches) for maintenance 
and wiring. 

 Plan your mechanical installation based on the electrical requirements of 
your application. Reference the General Electrical Installation Guidelines in 
Chapter 4. 

It is important that you follow all safety precautions when installing, setting 
up, operating, maintaining, troubleshooting or replacing any Accu-Sort 
products, parts or related equipment. Reference Chapter 2, Safety. 

 

Attaching the Wiring Base 

If your application is not using the universal or X-pattern mounting brackets 
(UMB or XMB), mount the wiring base to any flat surface with three mounting 
screws.   

The U.S. version’s (0104636001) mounting holes have #10-32 UNF-2B threads. 
The metric version’s (0104636002) mounting holes have M5 x .8-6H threads.   

The length of the screws must not be greater than 0.5 inch (12.5 mm) plus the 
thickness of the mounting surface. 

Use the following diagram as a reference to create a mounting template. 

 
Figure 3-8: Wiring Base Mounting Dimensions (not actual size) 
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Attaching the Universal Mounting Bracket (UMB) 

The Universal Mounting Bracket (PN 0105307002) is an optional accessory 
that simplifies Axiom mounting and installation. Included with the bracket is 
the necessary hardware to attach it to the mounting structure.  

1. When using this option in your application, follow the assembly 
instructions provided with the universal-mounting bracket (UMB).  

2. Attach the UMB to the mounting structure with the provided hardware. 

3. Mount the wiring base to the UMB. (See Figure 3-9.) Use the three screws 
provided with the wiring base.  

4. Insert the screws through the UMB into the threaded holes on bottom of 
wiring base. 

5. DO NOT over-tighten screws. Leave the three screws slightly loose to allow 
for some movement in the wiring base so that final adjustment of the 
Axiom in relation to scanning area can be made after wiring is completed. 

 
Figure 3-9: Attaching Wiring Base to Universal Mounting Bracket (UMB) 
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Attaching the Axiom Power Supply to UMB 

The Axiom power supply, (PN 0105365001 for 120VAC or 0105365002 for 
240VAC), is an accessory to provide power to the Axiom when an alternative 
DC power source is not available. If the power supply is included for your 
application, the following diagram illustrates how it attaches to the plate and 
then to the Universal Mounting Bracket (UMB). 

 
Figure 3-10: Mounting Power Supply Assembly to UMB 

 

1. Mount the power supply to the power supply mounting plate with the 
provided hardware.  

2. DO NOT over-tighten screws that hold the power supply to the adapter 
mounting plate. 

3. Attach the power supply/mounting plate assembly directly to the UMB. 
Insert the two tabs on the edge of the mounting plate into their 
corresponding locations on the UMB. 

4. If the power supply/mounting plate assembly is properly positioned to the 
UMB, use the screw (located on the opposite edge of the mounting plate 
from the two tabs) to lock the assembly in place. 
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Attaching the X-Pattern Mounting Bracket (XMB) 

The X-Pattern Mounting Bracket (PN 0106226002) is an optional accessory 
that simplifies dual-Axiom-mounting installations to create an x-scanning 
pattern. (See Figure 3-11.)  

Included with the bracket is the necessary hardware to attach it to the 
mounting structure. (See also: Appendix A, XMB Dimensions.) 
 

 
Figure 3-11: X-Pattern Mounting Bracket (XMB) Assembly 
 

In most instances, the XMB is shipped from the factory with the wiring bases 
and power supply pre-mounted and pre-wired.  

 

If you need to perform this installation yourself, follow the procedure below: 

1. Attach XMB to mounting structure with the provided hardware (4 places). 

2. Mount both wiring bases to the XMB (2 places). (See Figure 3-12.) Use the 
three screws provided with each wiring base.  

3. Insert the screws through the XMB into the threaded holes on bottom of 
wiring base. 

4. DO NOT over-tighten screws.  

5. Reference drawing 17480 in Appendix D for wiring information. 
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Figure 3-12: Attaching Wiring Base to X-Pattern Mounting Bracket (XMB) 
 

Attaching the Axiom Power Supply to XMB 

The Axiom power supply (PN 0105914001 for 120VAC or 0105914002 for 
240VAC) is an accessory to provide power to two Axiom readers mounted to an 
XMB. If the power supply is included for your application, Figure 3-13 
illustrates how it attaches to the X-Pattern Mounting Bracket (XMB). 

 

 
Figure 3-13: Mounting Power Supply Assembly to XMB 

1. Mount the power supply to the power supply adapter mounting plate 
(included with the XMB kit). The XMB kit provides the necessary hardware.  

2. DO NOT over-tighten screws that hold the power supply to the adapter 
mounting plate. 

3. Attach the power supply/mounting plate assembly directly to the XMB. 
Fasten to the two tabs on the XMB as illustrated in Figure 3-13. 
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Mounting the Trigger Photoeye 
The standard Axiom photoeye works by bouncing a light beam off a reflector 
and detecting when something breaks the path of light. Use Figure 3-14 to 
help you mount your photoeyes. In order for photoeyes to work properly, make 
sure the following things are done when mounting the trigger photoeye option:  
 Mount trigger and reflector so the Axiom reader’s scan beam does not 

strike either of them. 
 Mount a reflector directly opposite the photoeye on the other side of the 

conveyor.  
 Install the reflector within the operating range of the trigger photoeye. 
 The photoeye must be mounted so the light exit window is perpendicular 

to the conveyor, facing the reflector. 
 The reflector must be mounted perpendicular to the conveyor, facing the 

photoeye. 
 

 IMPORTANT: The trigger photoeye’s beam (between photoeye and reflector) 
must be blocked by a package before the bar code is in position for scanning.  
The trigger signal should remain active while the symbol is being scanned. 
This does NOT apply to tracking applications. 

 

 
Figure 3-14: Photoeye Mounting Diagram 
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Mounting the Tachometer 
The tachometer (tach) option outputs a set number of pulses for each wheel 
rotation. This tells the Axiom the precise conveyor speed, allowing it to 
determine the exact package position. Tracking allows for multiple boxes to be 
in the scan window at the same time. Bar codes on each box are decoded and 
assigned to the correct box. Because the exact layout of many conveyors is 
unique, it is impossible to give you exact directions for mounting your 
tachometer. Follow the guidelines below as closely as possible when mounting. 
 
 Tachometers are often used in systems with several conveyor belts. Mount 

the tach on the section of the conveyor the scanning is performed on. 
 Mount the tach on the underside of the conveyor, away from areas where 

the conveyor bows downward. A good place to mount the tach is on one 
end of the conveyor, underneath the drive shaft. 

 Make sure the tach assembly angles in the same direction that the 
underside of the conveyor travels, as shown in Figure 3-15. 

 The tach must make good contact with the conveyor.  
 Use the general mounting kit (1000020567, see Figure 3-15) to make 

tachometer mounting and setup easier. The extrusion mounting kit 
(1000020568) is the same as shown here, but also includes mounting 
hardware for attaching to Accu-Sort mounting structures. 

 If you are not using the tachometer mounting kit, create a weight or spring 
assembly to put tension on the back of the tachometer, ensuring that the 
wheel makes strong contact with the conveyor.  

 
Figure 3-15: Tachometer Mounting Kit Installation 
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Mounting the I/O Modules 

The wiring base supports four (4) optional input or output modules that can be 
used for optional trigger inputs or to operate diverters, alarms, etc. The 
optional I/O modules are not installed at the factory.  

 
Figure 3-16:  I/O Module Location in Wiring Base 

To install your optional I/O module(s): 

1. Lift the insulating cover (shown in figure above) out of the way to gain 
access to the wiring base printed circuit board. 

2. The I/O modules may be plugged into locations I/O 1 through I/O 4. These 
locations run right-to-left, as shown on the insulating cover label.  

3. Plug the appropriate I/O module directly into the wiring base printed 
circuit board. (See Figure 3-17, left photo.) 

4. Using a screwdriver, secure the I/O module by tightening the captive screw 
(that goes through the module) into the circuit board. DO NOT over-
tighten screw. (See Figure 3-17, right photo.) 

 

Figure 3-17: Installing an I/O Module 

 

I/O MODULE APPLICATIONS 
 
OUTPUT MODULES 
 Activate diverter/sorter for no 

read, multi-read, match, or no 
match conditions. 

 Activate device (e.g., beacon light) 
to indicate any of the above 
conditions. 

 Activate device for use as a “life 
condition’ indicator. 

 Activate device to follow the 
trigger condition. 

 Activate alarm. 
 
INPUT MODULES 
 Additional photoeye input for 

Start/End Trigger 
NOTE: The following input module 
applications require custom 
software. 
 Transmit photoeye 
 Divert Accomplished photoeye 
 Reboot signal 
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 Installing a Scan Head 

Perform the electrical installation as outlined in Chapter 4. Once all wiring is 
checked for accuracy, install the Axiom scan head to the wiring base. (See 
Figure 3-18.)  You can install the scan head with or without the power 
disconnected from the wiring base. 

To install a scan head: 

1. Make sure the insulating cover is in position, so the flap covers the field 
wiring connections inside the wiring base. 

2. Carefully align the 3 scan head alignment pins with the 3 holes in the 
wiring base. This automatically assures the correct scan head-to-wiring 
base connector alignment (to avoid bending pins). (See Figures 3-19, 20.) 

3. Gently, press the scan head down until it firmly connects with the wiring 
base. 
 

 
Figure 3-18: Axiom Scan Head Installation on Wiring Base 

 

 Figure 3-19: Connecting Axiom Scan Head to the Wiring Base 

Alignment 
Pin 

Scan Head 
Connector 

Wiring Base 
Connector
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Figure 3-20: Axiom Scan Head Alignment Pin Locations 
 

4. Secure the scan head to the wiring base with the four captive screws.   

5. Alternately tighten screws. DO NOT over-tighten screws. 
 

 
Figure 3-21: Axiom Scan Head Captive Screw Locations 
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4   Electrical Installation 
 

 WARNING: Electrical Installation by Qualified Service Technicians Only! 
Several procedures involve exposure to voltage inside the wiring base. A 
trained technician must perform these procedures. Do not attempt to perform 
any electrical installation procedures unless you are a trained technician. 

 IMPORTANT: The Axiom is an electronic microprocessor-based unit.  To 
prevent personal injury or damage to the unit (caused by electrostatic 
discharge (ESD)), please follow the safety precautions and warnings found in 
Chapter 2. Failure to follow these precautions may void your warranty. 

 

Preparing for Electrical Installation 

Before mounting any components, please do the following: 

 Read all instructions before beginning your installation.  

 Define and confirm the accuracy of your application’s requirements.  
(See What You Need to Know about Your Application, in Chapter 3.) 

 Review all installation-specific drawings.  

 Review and plan the power requirements for your application. 

 Review and plan the communications requirements for your application. 

 Install the Axcess setup software on your PC. (Reference Axcess Software 
Manual. See Chapter 2, Getting Started.) 
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Installation Sequence(s) 

 USEFUL TIP: Everything should be MECHANICALLY INSTALLED before 
performing any ELECTRICAL INSTALLATION. Reference Chapter 3 for 
mechanical installation details. 

 

Installing a Single Unit 
To install a single unit, follow this sequence of steps: 

 Complete mechanical installation. 

 Reference Chapter 3. 

 Complete electrical installation. 

 Ground the mounting structure to protective earth (PE) ground.  
(See Figure 4-3.) 

 Ground the wiring base to protective earth (PE) ground.  

 Connect the power supply to wiring base. 

 CHECK POLARITY. (See page 4-10.) 

 Connect trigger to wiring base. (See page 4-11.)  

 Connect tachometer to wiring base. (See page 4-12.) 

 Connect necessary communications to wiring base. (See page 4-13.) 

 Connect wiring for I/O module(s) to wiring base. (See page 4-15.) 

 Attach scan head to wiring base. (See page 4-17.) 

 NOTE: To reduce the possibility of damage to the scan head, install it after 
the wiring base is mounted, wired, and all wiring is checked for accuracy. Be 
sure to perform the polarity check before attaching the scan head. 

 Setup your Axiom.  

 Reference Chapter 5. 

 Check operations.  

 Reference Chapter 5. 

 
Installing Multiple-Readers 

For electrical installation, multiple-reader networks will require a different 
approach to wiring, since the power source, trigger photoeye, and tachometer 
are most likely being shared by the group of readers. (Reference drawings 
107480 and 107481 in Appendix D.) 

Special instructions for functional set-up of a multi-reader network are 
provided in Chapter 5. 
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General Electrical Installation Guidelines and Precautions 

It is important that you follow these general precautions when installing, 
setting up, operating, maintaining, troubleshooting or replacing any Accu-Sort 
products, parts or related equipment.  

 

 

CAUTION: The Axiom uses Class 3R lasers IEC, (Class II CDRH). Avoid staring 
at the laser light source. While laser light does not constitute a health hazard, 
staring at the laser for prolonged periods could result in eye damage. 

 

As you plan and install your Axiom bar code solution application, be sure to 
keep the following guidelines in mind: 

 Determine the reader is in the proper orientation and position as outlined 
in Chapter 3. 

 Leave adequate clearances (approximately 8-12 inches) for wiring. 

 The wiring base has four conduit openings. Seal unused openings. Use cord 
grips with rubber grommets on cables that enter the wiring base. 

 Route wires carefully to reduce or minimize electrical noise. When power 
and communication wiring must cross, make their intersection 
perpendicular. 

 Proper grounding of the wiring base limits the effects of noise due to 
Electromagnetic Interference (EMI). 
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Wiring the Axiom 

After completing mechanical installation, use this section to properly wire you 
Axiom for optimal performance in your application. All wiring connections to 
the Axiom are made via the wiring base. 

Use the four conduit openings for running wires into the base. Route your 
cabling for input/output power, tachometer, trigger, communications, and I/O, 
through the recommended conduit openings. (See Figure 4-1.) 

 
Figure 4-1: Recommended Cabling to Axiom Wiring Base 

 
Wiring tables, printed on the wiring base insulation cover, help simplify 
installation. (See Figure 4-2.)  Remember: Wire to the terminal blocks, left-to-
right, coordinating your wiring with the table, top-to-bottom.  

 

 
Figure 4-2: Wiring Tables on Wiring Base Insulating Cover 

Ethernet  
and/or Serial 

Serial OR  
I/O Modules, 
Output Power 

Tach and 
Trigger 

Input 
Power 
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Figure 4-3: Example of Proper Wiring 

 

 WARNING: To assure no ESD damage will occur, be sure to observe the 
precautions outlined in Chapter 2, Safety. 

 

 IMPORTANT: Ground the wiring base to safety ground (protective earth 
ground (PE)) as shown in Figure 4-3. Reference wiring recommendations for 
safety ground. (See Table 4-1.) 

 
Only use connectors designed for connecting to aluminum. Reference:  
 UL 486B Wire Connectors for use with Aluminum Conductors,   
 UL 486C Splicing Wire Connectors, and 
 UL 486E Equipment Wiring Terminals for use with Aluminum and/or Copper Conductors  

Protective 
Earth 

Ground 

Ground Location 
for Output Power
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Cable and Conduit Connections 

Determine the wiring connections needed for your application. All permanent 
connections are made to the wiring base with either cables or through conduit. 
Wiring bases are shipped with four (4) cord grips and three (3) hole plugs. Be 
sure to follow Accu-Sort’s wiring recommendations. (See Figure 4-1 and Table 
4-1.) 

 

Table 4-1: Wiring Recommendations 

Connection Recommended Wiring Type Max. Length 

Safety Earth 
Ground 

For 15-20 Amp branch circuit, use #18 AWG min. 
For 16-25 Amp branch circuit, use #14 AWG min. 
For 26-32 Amp branch circuit, use #12 AWG min. 

 

Power #20 AWG minimum   
RS232 #24 AWG minimum  50’ [15.2] 
RS422 #24 AWG minimum  1000’ [300] 
Ethernet #24 AWG CAT5 UTP (unshielded twisted pair) 330’ [100] 
Tach / Trigger #24 AWG minimum   
I/O Modules Depends upon module rating. See Appendix A.  

NOTE: ALL external wiring must be UL listed or recognized rated VW-1 or FT-1 and 
conforming to NEC ANSI/NFPA 70. 

Cord Grips Recommended Wiring Diameters 

Small Diameter Accommodates 0.191 to 0.354 inches (4.9 to 9.0 mm) 
Large Diameter Accommodates 0.236 to 0.472 inches (6.0 to 12.0 mm) 

 

 

Cable Connections to Wiring Base 

 Where the cabling enters the wiring base, use the supplied cord grips with 
rubber grommets. (See Figure 4-4, left illustration.)   

 Each cord grip comes with two different size grommets. Use the grommet 
size that provides the tightest fit. 
 

 NOTE: To maintain an IP65 rating, only one cable may be run through each 
conduit opening. If running two or more cables into one opening, use a 
plumbing “T” connector to assure the Axiom will be watertight. 
 

 Make sure you use Teflon tape (or other thread sealant) to maintain an 
IP65 rating. 

 Once all cabling is completed, plug all unused wiring base openings.  
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Conduit Connections to Wiring Base 

 Where the conduit meets with the wiring base, you will need to supply the 
correct conduit fittings. (See Figure 4-4, right illustration.)   

 Use flexible conduit whenever possible to allow for Axiom range of motion 
adjustments, especially when the UMB is used.   

 Once all conduit connections are completed, plug all unused wiring base 
openings.  

 

Cable

Grommet

Nut

Threaded Bushing

Hole Plug
(U.S. )

Hole Plug
(Metric )

Cord Grip
Conduit Fitting

Conduit

Wires

Hole Plug
(U.S. )

Hole Plug
(Metric )

User Supplied

Figure 4-4: Cabling, Conduit, and Hole Plugs on Axiom Wiring Base 

 

Plug Unused Wiring Base Openings 

 Three (3) wiring base hole plugs are supplied.  Use these plugs on unused 
openings. All unused openings MUST be plugged to maintain IP65 rating. 
Use Teflon tape (or other thread sealant) when inserting the hole plug in 
the conduit opening. 

 U.S. version wiring base (PN 0104636001) conduit openings have 1/2-14 
NPSC threads. Use an NPSC threaded plug on all unused conduit openings. 
Tighten hole plug(s) with a 3/8" hex wrench. 

 Metric version wiring base (PN 0104636002) conduit openings have 
PG13.5-18 threads. Use a threaded hole plug on all unused conduit 
openings. Tighten hole plug(s) with a flat-blade screwdriver. 

 

Power Requirements 

 IMPORTANT: When planning your installation wiring, remember all power 
connections must be quick-disconnect. For PERMANENTLY CONNECTED 
EQUIPMENT (i.e., Axiom using DC power) a readily accessible disconnect 
device must be incorporated in the building installation wiring. For 
PLUGGABLE EQUIPMENT (i.e., Axiom using AC power supply with non-
detachable power cord), the socket-outlet must be installed near the 
equipment and must be easily accessible. 
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Power Supply Connections 

 CAUTION: While performing the following wiring connection procedures, be 
sure to follow all safety procedures regarding high-voltage as outlined in 
Chapter 2, Safety.  No power should be applied to any device until all wiring is 
completed and checked for accuracy. 

 REMEMBER: The socket-outlet must be installed near the Axiom’s power 
supply. The outlet must be a readily accessible disconnect device. 

 

Using Accu-Sort Power Supplies 

Single Reader  The Axiom reader requires 30 watts (maximum) of power. Two 
Accu-Sort power supplies are available. These power supplies are IP65 rated for 
industrial environments.  

 120 VAC Power Supply (PN 0105365001) plugs directly into a standard 
wall electrical socket. 

 240 VAC Power Supply (PN 0105365002) supplied with an IEC 320 
molded connector power cord.  

1. Connect the power supply wiring to the terminal block inside the wiring 
base. The arrow on the figure below indicates the location of the terminal 
block.  

2. Make sure wiring cannot come loose.  

3. DO NOT over-tighten screws on terminal blocks. 

4. The proper location for ground is shown on Figure 4-3. 

 

 
Figure 4-5: Input Power Wiring (Power Supply) 

 

 CAUTION: The INPUT POWER wiring table indicates 2.5A output load. This is 
for applications using other power supplies. The Accu-Sort power supply can 
handle an output load of 250mA. 
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Multiple Readers  When a multiple reader application uses Accu-Sort power 
supplies, each Axiom is powered by a separate power supply. DO NOT connect 
power supplies in parallel.  (Reference drawing 107481 in Appendix D.) 

Axiom X-Pattern Applications  When using two Axioms and the X-pattern 
mounting bracket (XMB), a 110W supply is available from Accu-Sort that 
provides power to both readers. (Reference drawing 107480 in Appendix D.) 

 

Power Connections Using Other Power Supplies 

 IMPORTANT: All non Accu-Sort power supplies, whether for single or 
multiple reader applications, must be an LPS or Class 2 power supply. The 
supply must provide 30 watts (12-30 VDC) of power to each Axiom.   

 

Single Reader  When a single reader application uses a non Accu-Sort supply, 
follow the INPUT POWER wiring table to assure proper wiring.  

 

Multiple Readers  When using a non Accu-Sort supply with multiple readers:   

1. Follow the INPUT POWER wiring table to assure proper wiring to the first 
Axiom in the wiring daisy-chain. 

2. By using the OUTPUT POWER terminal block (shown in the figure below), a 
total of three Axiom readers may share a power source. NO MORE than 
three Axiom readers may be daisy-chained to one power source. 

3. Wire a cable from the OUTPUT POWER of the first Axiom to the INPUT 
POWER of the second Axiom. 

4. Wire a cable from the OUTPUT POWER of the second Axiom to the INPUT 
POWER of the third Axiom. 

5. Wiring MUST be grounded at both ends of the INPUT POWER and OUTPUT 
POWER connection. (See Figure 4-3.) 

 
Figure 4-6: Output Power Wiring 

 CAUTION: The OUTPUT POWER wiring table indicates a maximum 2.5A 
output load. This is only for applications using other power supplies providing 
a minimum of 86.5 W of power.  
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Polarity Check 

After completing the power connection, and before connecting other devices to 
the wiring base, be sure to perform a polarity check. When power is applied to 
the Axiom wiring base, other devices wired to the Axiom (i.e., tachometer and 
photoeye) could be damaged if the power polarity is reversed. 

 ATTENTION: While performing the polarity check, be sure to follow all safety 
procedures regarding high-voltage as outlined in Chapter 2, Safety.  Before 
correcting a polarity problem, be sure to disconnect the power source. 

 IMPORTANT: After completing power connections, check Polarity LED inside 
the wiring base. A GREEN LED indicates polarity is correct. When more than 
one Axiom are daisy-chained together, check polarity in the correct sequence. 

 
Figure 4-7: Location of Polarity LED in Wiring Base 

 
1. Apply power.  
2. Check that all Polarity LEDs are GREEN. If multiple Axiom are daisy-

chained together, check the polarity of the first unit in the chain (i.e., unit 
wired directly to power source), then the second, then the third. If all 
Polarity LEDs are GREEN, polarity is correct. 

3. If any Polarity LEDs are RED, polarity is reversed and must be corrected.  
4. Disconnect from power source. 
5. Correct wiring. For single units, simply swap the wiring at the INPUT 

POWER terminal block of any unit that had a RED polarity indication. In a 
daisy-chain, correct the wiring on the first unit in the daisy-chain that had 
a RED polarity indication.  

6. Reconnect to power source. 
7. Apply power. 
8. Check polarity to assure wiring has been corrected. 
9. If all Polarity LEDs are GREEN, polarity check is complete. 
 

 USEFUL TIP: In daisy-chained power applications, if the first or second unit’s 
Polarity LED is RED and the last unit‘s LED is GREEN, you need to swap the 
INPUT POWER wiring of the first unit with RED LED and the OUTPUT POWER 
wiring of the last unit with RED LED. 
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Trigger Connections 

The Axiom supports three trigger modes: hardware, software, and continuous. 
When using hardware trigger, one or more input signals “trigger” the reader. 
Software trigger is accomplished by sending a specific ASCII message via serial 
or network communications. Continuous trigger requires no external trigger. 

When a hardware trigger (i.e., package detector) is required, Accu-Sort’s retro-
reflective photoeye (PN 100020569) is recommended.  

 
Figure 4-8: Wiring Trigger to Axiom Wiring Base 

 
Connect trigger wiring to the wiring base terminal blocks. (See Figure 4-8.) 
Wire the Accu-Sort photoeye as indicated in shaded area of Table 4-2. (Wire 
colors indicated for standard NPN Output, shown in shaded areas.) 

Table 4-2: Trigger Photoeye Wiring 

WIRE COLOR TERM NPN OUTPUT PNP OUTPUT 24V 
RED V + Supply Voltage Supply Voltage 

(Jumper to V+) TRIG + Jumper to V+ Photoeye Output + Output 
WHITE TRIG - Photoeye output Jumper to GND - Output 
BLACK GND Common Common 

 

If your application uses a photoeye other than the one available from Accu-
Sort, follow the TRIGGER wiring table to assure proper wiring. The trigger must 
be able to operate using the +24V DC source (24V) and not draw more than 
100mA.  The trigger input must be able to sink (or source) 10mA at +24V DC. 

 

 USEFUL TIP: To confirm the Trigger photoeye is functioning properly, watch 
the Trigger LED while the photoeye’s beam is blocked. (See Chapter 5 for 
details.) The Accu-Sort photoeye also includes a status LED. 

 
Multiple Readers    When an application incorporates multiple readers wire 
the trigger photoeye to the Axiom Controller. (Reference drawings 107480 and 
107481 in Appendix D.) 
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Tachometer Connections 

In applications where product tracking is required, a tachometer is typically 
used. Connect the tachometer wiring to the wiring base terminal blocks.  
(See Figure 4-9.)  

 
Figure 4-9: Wiring Tachometer Input to Axiom Wiring Base 

When a tachometer is required, Accu-Sort tachometer (PN 1000019875) is 
recommended. Wire this tachometer as indicated in shaded area of Table 4-3. 
(Wire colors indicated for standard NPN Output, shown in shaded areas.) 

Table 4-3: Tachometer Wiring  

TACH WIRE COLOR TERM NPN OUTPUT PNP OUTPUT 24V 
WHT/ORG V + Supply Voltage Supply Voltage 

(Jumper to V+) TACH + Jumper to V+ Tach Output + Output 
WHT/BLU TACH - Tach Output Jumper to GND - Output 

BLU/WHT+ORG/WHT GND Common Common 

The shielding for the tachometer wiring MUST be terminated to earth ground. 
(See Figure 4-10.) Otherwise, belt static could result in a system failure. 

 
Figure 4-10: Tachometer Shielding Terminated to Earth Ground 

If your application uses a tachometer other than the one available from Accu-
Sort, follow the TACH wiring table to assure proper wiring. 

 

Multiple Readers    When an application incorporates multiple readers wire 
the tachometer to the Axiom Controller. (Reference drawings 107480 and 
107481 in Appendix D.) 
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RS232/422 Communications Connections 

The wiring base provides an RS232/RS422 terminal block for serial point-to-
point communications. Typically, network communications will use Ethernet.  

 

 
Figure 4-11: Serial Communications Wiring (RS232/422)  

 

RS232 Connections 

Use RS232 for a direct connection to a controller, personal computer, or other 
device. RS232 provides point-to-point communications at distances up to 50 
feet (15.2 meters). If longer cable lengths are needed, use RS422. RS232 
connections are made to the SERIAL COM terminal block. Follow the SERIAL 
COM / RS232 wiring table to assure proper wiring. 

 

 IMPORTANT: Before attempting to use RS232 communications with 
RTS/CTS, contact Accu-Sort Customer Service for additional information. 

 
 

RS422 Connections 

Use RS422 for a direct connection to a controller, personal computer, or other 
device. RS422 provides point-to-point communications at distances up to 1000 
feet (300 meters). RS422 connections are made to the SERIAL COM terminal 
block. Follow the SERIAL COM / RS422 wiring table to assure proper wiring.  

Line Termination    The end devices on an RS422 point-to-point connection 
must be terminated.  A termination resistor is pre-installed in the wiring base.  
The HOST end of the connection must also be terminated using a 120-ohm 
resistor between the RECEIVE+ and RECEIVE- terminals. 
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Ethernet Communications Connections 

Use Ethernet for network/host communications or multiple-reader networks. 
Ethernet communications cabling can be run up to 330 feet (100 meters). 
Ethernet connections are made to the ETHERNET terminal block. Follow the 
ETHERNET wiring table to assure proper wiring.  

 

 
Figure 4-12: Ethernet Connections to Wiring Base Terminal Block 

 

 IMPORTANT: Do not strip wires before inserting them into the Ethernet 
terminal block.  
 

 

For additional details on Ethernet and EtherNet/IP communications, reference 
the Axcess for Axiom Software Manual, Appendix A: Guide to Axiom 
Networking.  Another useful source of information is the ODVA official web 
site (www.odva.org).  

 

 USEFUL TIP: To simplify your network installation, Accu-Sort offers the 
following options: 

 RJ45 adapter cables (10 and 20 ft. lengths) 

 a 5-port Ethernet switch (Linksys) and 

 an 8-port dual speed Ethernet switch (10/100).  

(See the Options and Accessories listed in Appendix A.) 

 

Multiple Readers   Most multi-reader applications will use Ethernet or 
EtherNet/IP communications.  Reference the following drawings in Appendix D 
for wiring details:   

 107480 - Controller/Client with tachometer  

 107481 - Controller/Client/Client with tachometer 
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I/O Module Connections 

The wiring base supports up to four (4) optional input or output (I/O) modules. 
Any of the modules shown in Table 4-4 may be used.  These modules function 
like switches; they do not supply a voltage. (See Appendix A.)  

Connect I/O wiring to the correct terminal blocks.  When using DC modules, 
observe the polarity of the connections illustrated on insulating cover label. 

 

 
Figure 4-13: I/O Module Wiring 

 

Table 4-4: Available I/O Modules for use with Axiom 

Part Number Description Color Rating Current Range 

1000056135 DC Input Module  white 3.3 to 32 VDC 32 mA 

1000056136 DC Output Module red 3 to 60 VDC 3 A max. * 

1000056137 AC Output Module black 12 to 42 VAC 3 A max. * 

NOTE: Relay modules are only for connection to SELV, LPS power source. 

* Derate 33mA/deg above 25C. 
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Output Module Application 

Shown below is a typical output module application.  When connecting high 
impedance loads, you may need to add a resistor in parallel with the load.  This 
resistor (typically 300 to 6,000 ohms) provides a continuous minimum current 
flow (10 mA DC or 50 mA AC) through the output module in the closed state.   

 

-+

AC or DC Source

Optional Resistor

Fuse
Recommended

Load

 

 

Back Electromotive Force (EMF) is sometimes generated when an inductive 
load is switched off.  Back EMF may damage the output module.  A diode in 
parallel with the inductive device dissipates the back EMF. 

-+

DC Source

Optional Diode

Fuse
Recommended

Inductive
Load

 

An example output module application is the use of a Stack Light. The Axiom 
could use three output modules.  Each module will send an output signal to the 
stack light to visual indication specific conditions (e.g., green = read, yellow = 
multiple codes, red = no read). (Reference drawing 107483 in Appendix D.) 

 

Input Module Application 

Input module 1000056135 is most often used for an END TRIGGER photoeye 
application. (Reference drawing 107482 in Appendix D for wiring details.)  

 

 NOTE: Any other input module application requires custom software. Contact 
Accu-Sort Customer Service for more information. 

 

-
Output Module TB

+

-
Output Module TB

+



AXIOM™ 400 Product Manual Electrical Installation 4-17 
  

04-AXIOM400-Electrical_Installation_R10.doc Accu-Sort Systems, inc. 

Installing a Scan Head 

Once all wiring is completed and checked for accuracy, install the Axiom scan 
head to the wiring base. (See Chapter 3.)  You can install the scan head with or 
without the power disconnected from the wiring base. 

 

Check Axiom Installation 

After completing the installation of your Axiom: 

 Confirm that the Axiom has been properly installed mechanically and 
electrically. Use the Installation Sequence at the beginning of this chapter 
and your application specifications to check your installation. 

 Configure the Axiom’s parameters to meet the needs of your application. 
(See Axcess Setup Software Manual and online help for details.) 

 See Chapter 5 for details regarding first-time startup and an operations 
checklist. 
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Notes: 
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5 Setup and Operations 
 

This chapter provides details on how the Axiom bar code scanning solution 
functions during normal operation. It also outlines how you can verify optimal 
performance through several methods: 

 Become more familiar with your Axiom application 

 Step-by-step start-up operations checklist 

 Status Indicator LEDs 

 Diagnostics to confirm normal operations (using Axcess) 

After configuring your Axiom reader using the Axcess Setup Software, use the 
operations checklist to verify normal operations. (Reference Chapter 4 of the 
Axcess Software Manual.) 

 

First-time Startup 

On initial power-up, the Axiom performs a series of self-diagnostic and LED 
tests. The complete power-up sequence takes about 30 seconds.  

When the STATUS LED flashes and turns a steady green the power-up sequence 
is complete.  The Axiom is now operational.  

 

 USEFUL TIP: When an application uses multiple Axiom readers, you can 
provide each reader with a unique reader name using the Axcess setup 
software. This makes it easier to keep track of reader parameter changes 
when working with several readers on a network. (Reference Chapter 4 of the 
Axcess Software Manual for details.) 

 
 

Default Parameters 

The Axiom is shipped from the factory with these defaults:  

 Connection Mode: Setup Cable  

 Reader Name: Axiom 

 Control Panel Buttons Enabled  

 Code 128 (10-30 characters) 

 IP address 192.0.0.100 

Perform the following setup procedure using these defaults or configure your 
Axiom with your application’s parameters using the Axcess Setup Software. 
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First-time Setup 

Every application is unique. Axiom is designed for ease-of-setup, allowing you 
to program the reader to fit your application seamlessly. 

Axcess Setup Software for Axiom, functioning under the familiar Windows® 
operating system on your PC, is the tool you will use to define operating 
parameters, set bar code type / length, and construct output messages, 
including filtering, stripping and padding capabilities. Axcess enables you to 
easily configure, fine-tune, and monitor your Axiom’s operations.  

Axcess provides ease-of-use regardless of your experience with bar code 
readers. A beginner follows basic setup procedures for a standard 
configuration. If you are more experienced, use the advanced setup features 
that allow access to more complex options. In either case, the user-friendly 
Axcess Wizard efficiently guides you through a sequence of screens until the 
Axiom is configured to fit your application. 

Reference the Axcess for Axiom Setup Software Manual for further information. 
 

First-time Setup Procedure 

To setup your AXIOM 400 bar code reader:  

1. Install Axcess on the PC you will use to setup your Axiom. 

2. Connect the programming setup cable to the Axiom. 

3. Connect the programming setup cable to your PC. 

4. Apply power to Axiom. 

5. Set configuration parameters using Axcess for bar code symbologies, 
trigger, tracking, and communications (serial, Ethernet, and I/O). 
Reference Axcess Software Manual, Chapter 2, Getting Started. 

6. Check operations using the Test Mode. 

 

Check Operations using Test Mode 

 NOTE: Perform the following test using a bar code that matches the default 
parameters. Or you may wish to perform this test after configuring the Axiom 
to your specifications. If the default parameters have been changed, you must 
enable the control panel buttons and the other parameters listed on page 5-1. 
Reference Axcess Software Manual, Chapter 4.  See Modify > Axiom 
Configuration and Modify > Bar Code Setup. 

 

To quickly check the operation of an Axiom: 

1.  Apply power to the Axiom. 

2. Position a test bar code symbol approximately 20 inches (0.5 meter) from 
the reader.  Skew the bar code symbol slightly. 

3. Press the Test/Diagnostics button on the control panel to initiate test. (See 
Figure 5-1, button C.)  
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4. The scan beam should be scanning continuously.  
(Observe the laser safety warnings in Chapter 2.) 

5. Observe the bar graph LEDs on the Axiom control panel.  The bar graph 
LEDs illuminate when the reader is scanning and decoding the bar code 
symbol. (See page 5-4.) 

6. Using the programming setup cable, connect your PC to the Axiom setup 
connector. You may also connect via a network. (Reference Axcess 
Software Manual, Chapter 3.) 

7. Run the Axcess setup software and establish a connection with the Axiom. 

8. Using Axcess Explorer, go to the Diagnostics > Axiom Monitor. 

9. During operations, use the Axiom Monitor to confirm the reader’s status, 
read quality, code quality, and messages via the on-screen indicators. 
(Reference Axcess Software Manual, Chapter 6.) 

10. Close the connection to the Axiom. 

11. Disconnect setup cable. 

 

Operations Checklist 

 Check trigger photoeye LED for proper operation. 

 Test Axiom parameters to assure optimal operation. 

 Observe the Axiom’s Status Indicator LEDs during power-up.  
(What to watch for is outlined on page 5-4.) 

 Using Axcess Explorer, select Diagnostics > Axiom Monitor.  
(See Axcess Software Manual, Chapter 6.) 

 Pass test label in scanning beam. 

 Adjust mounting as needed for optimal performance. 

 Modify Axiom parameters as needed for optimal performance. 

 Save parameters to scan head. 

 Backup parameters from scan head to wiring base. 
(See Table 5-3.) 

 Backup parameters to disk (optional, but recommended). 
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Axiom Control Panel Indicators 

The LEDs provide the following indications during normal operations. 
 

 
Figure 5-1: Axiom Control Panel (on scan head)   
 
Table 5-1: Using LED Indicators to Check Normal Operations 

Ref LED Description 

 1  Status GREEN to indicate the overall "health" of the reader.  
(If RED, see Chapter 7, Troubleshooting.)  

 2  Trigger Indicates the trigger input. The LED is activated upon trigger 
input regardless of trigger source (incl. software trigger).  

 3  Read Flashes red or green based upon the software criteria.  

 4  RX/TX LED for serial port 1.     GREEN = Transmitting data  
                                        RED = Receiving data 

 5  Network  Flashes red or green to indicate connection status.  

 For a Single TCP/IP connection, it indicates that a 
"host" connection has been made to the reader.  

 For EtherNet/IP connection, it indicates "network" 
connection status. This LED is software controlled. 

 For a Controller/Client multi-reader connection, it 
indicates that all inter-reader communications 
(connections between readers) are correctly 
functioning.  

(See Table 5-2.) 

 6  Link This LED is LINK indicator for Ethernet. 
Flashes GREEN when connected to a network. 

 7  Bar Graph 
(LED 1 - 5) 

Scan quality indicator. Also flashes whenever copying 
parameters to/from wiring base.  
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Table 5-2: Network LED during Normal Operations 
Mode Description 
Single TCP/IP Solid GREEN – Axiom connected to a host.   

NOTE: If both Host 1 and Host 2 are used, the LED will be solid 
GREEN if either port is connected. 
Off – No host connection. 
NOTE: If UDP messaging is used (unconnected messages) the 
Network LED will be off. 

EtherNet/IP Solid GREEN – Axiom made a connection to the PLC 
Flashing GREEN – No connection made with the network 
Flashing RED – Lost network connection 

Controller/Client Controller 
Solid GREEN – The correct number of client(s) with the same 
group number have been found. 
Flashing RED – All the client(s) with the same group number 
have NOT been found 

Client 
Solid GREEN – Connected to a controller with the same group 
number. 
Off – Not connected to a controller with the same group 
number. 

NOTE: The mode indicated by the Network LED is dependent on the Axiom 
configuration you are using.  Ethernet/IP is the highest priority, Single TCP/IP mode 
operation is the lowest. 

 
 
Table 5-3: Using Control Panel Buttons to Check Normal Operations 
Ref Button Description 

 A  Upload to Axiom Uploads parameters from Wiring Base to Scan Head 

 Button must be pressed twice to initiate action.  

 The bar graph LEDs flash when pressed once.  

 The bar graph LEDs strobe from 1 to 5 when pressed 
the second time, indicating the parameters are being 
uploaded from the wiring base to scan head. 

 B  Backup to Base Downloads parameters from Scan Head to Wiring Base 

 Button must be pressed twice to initiate action.  

 The bar graph LEDs flash when pressed once.  

 The bar graph LEDs strobe from 5 to 1 when pressed 
the second time, indicating the parameters are being 
backed up from the scan head to the wiring base. 

 C  Test /Diagnostic Enables the Axiom test mode.  

(Test mode can also be selected remotely using Axcess 
Tools > Axiom Commands > Test Mode.)  

 

 REMEMBER: Axiom’s control panel buttons can be enabled/disabled through 
the use of the Axcess setup software. (Reference Axcess Software Manual. See 
Modify > Axiom Configuration, Enable Axiom Control Panel Buttons.) 
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Checking Operations with Axcess 

The Axcess Diagnostics > Axiom Monitor enables you to evaluate the 
operational performance of your Axiom by providing vital statistics via status 
indicators, real-time read quality monitoring, and box information. Outgoing 
and incoming messages are also monitored. 

 
Figure 5-2: Axcess Diagnostics > Axiom Monitor Window 

 

Checking Multi-Reader Network with Axcess 

From the Axiom Controller, check Diagnostics > Log Viewer > Read Rate. This 
simple diagnostic allows you to check bar codes read, by laser, for each Axiom 
Client in the network. Each client is identified in the Read Rate Log by the 
unique name and IP address assigned to it using Axcess.  

Reference the Axcess Software Manual and online help for more information. 

 
Figure 5-3: Example Read Rate Log for Multi-Reader Network 
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Standalone Operation 

In a typical standalone setup, a single Axiom scans bar codes on one side of 
packages as they move down a conveyor. A photoeye is used to trigger the 
Axiom to begin searching for valid bar codes. Bar code data is transmitted to a 
host device. 

 
Figure 5-4: Typical Single-Unit Axiom Application  

 

A simplified schematic diagram of the required items is shown below: 

2

43

1AXIOM Wiring Base

PN 0104636001 (US)
PN 0104636002 (Metric)

AXIOM
Scan Head

(4 options available)

Photoeye
PN 1000020569

Network/Host
Communications

PC

Universal Mounting
Bracket

PN 0105307002

Programming Cable
PN 1000007308

Power Supply
PN 0105365001 (120V)
PN 0105365002 (240V)

AC Power

 

Figure 5-5: Schematic Diagram of Typical Single-Unit Axiom Installation 
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Tracking Operation 

By utilizing the tracking capabilities of the Axiom, you can configure your 
application to monitor the progress of packages on the conveyance system. 
Tracking enables the Axiom to track bar codes and the packages to which they 
belong. Your reader may scan more than one package with more than one code 
at a time within its read zone. Tracking allows the reader to accurately 
associate the correct bar code(s) with the correct packages.  

 

Typical tracking configurations use a tachometer to monitor conveyor speed.  

A simplified schematic diagram of the required items for a tracking application 
is shown below: 

2

43

1
Wiring Base

Axiom
Scan Head

PC

Photoeye

HOST Serial
CommunicationsTachometer

HOST Network
Communications

Setup

(Axcess)
 

Figure 5-6: Schematic Diagram of Axiom Tracking Installation 

 

Setup Functions for Axiom Tracking Operation 

 Modify > Tracking – Tachometer (define tach type) 

 Modify > Tracking – Axiom Mounting 

 Modify > Tracking – Transmit 

 Modify > Tracking – Track Config 

 

Reference the Axcess Software Manual and online help for details. 
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X-Scanning Operation 

In X-scanning applications, two Axioms mounted to an XMB bracket are used 
to create a single “X” scanning pattern. Two XMB brackets and four Axioms can 
be used to create a dual-X scanning pattern, as shown in Figure 5-7. 
 

View from conveyor (looking up) Dual X-pattern created by four Axiom 

Figure 5-7: Dual X-Scanning Application 

 
A simplified schematic diagram of the required items for an X-scanning 
configuration is shown below: 

Axiom (Controller)

PC

Photoeye

HOST Serial
Communications

Tachometer

Axiom (Client)

Wiring Base

Axiom (Client)

Axiom (Client)

HOST Network
Communications

Ethernet
Hub

 
Figure 5-8: Schematic Diagram of Axiom X-Scanning Installation 

 

Setup Functions for Axiom Controller 

 Modify > Axiom Configuration - Reader Name (Controller) 

 Network Settings - # of Client Readers, IP address, and Group # 

Setup Functions for Axiom Clients 

 Modify > Axiom Configuration - Reader Name (Client 1,2,3) 

 Network Settings – IP address and Group # 

Reference the Axcess Software Manual and online help for details on setting 
up a multi-reader network.  
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Multiple-Reader Network Operation 

In multiple-reader applications, from two to six Axioms can be networked 
together. A single Axiom is configured as a Controller for a multiple-reader 
network. The Axiom Controller gathers data from other Axioms (up to five, 
configured as clients) over an Ethernet network. The Axiom Controller then 
collects and transfers the collected data over a serial communications or 
network link to the host. 

A simplified schematic diagram of the required items for a multiple-reader 
configuration is shown below: 

Axiom (Controller)

PC

Photoeye

HOST Serial
Communications

Tachometer

Axiom (Client)

Wiring Base

Axiom (Client)

Axiom (Client)

HOST Network
Communications

Ethernet
Hub

 
Figure 5-9: Schematic Diagram of Multiple-Reader Axiom Installation 

 

Setup Functions for Axiom Controller 

 Modify > Axiom Configuration - Reader Name (Controller) 

 Network Settings - # of Client Readers, IP address, and Group # 

 

Setup Functions for Axiom Clients 

 Modify > Axiom Configuration - Reader Name (Client 1,2,3) 

 Network Settings – IP address and Group # 

 

Reference the Axcess Software Manual and online help for details on setting 
up a multi-reader network.  
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Scanning Array / Tunnel Operations 
When two multi-reader networks are coupled to function in the same scanning 
area, the entire application is called a scanning array or tunnel array. Due to 
the complexity of these applications, tunnel arrays are typically custom-
engineered to your specifications. Figure 5-10 illustrates a scanning array that 
uses ten Axiom readers in a six-sided tunnel configuration. 

 
Figure 5-10: Scanning Array / 6-sided Tunnel Application 

 
Setup Functions for Axiom Controller 

 Modify > Axiom Configuration - Reader Name (Controller) 

 Network Settings - # of Client Readers, IP address, and Group # 
 

Setup Functions for Axiom Clients 

 Modify > Axiom Configuration - Reader Name (Client 1,2,3,4,5) 

 Network Settings – IP address and Group # 

Reference the Axcess Software Manual and online help for details.  



5-12 Setup and Operations AXIOM™ 400 Product Manual 
 

Accu-Sort Systems, inc. 05-AXIOM400-Setup_and_Operations_R10.doc 

Notes: 
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6 Maintenance 
 

This chapter provides instructions for maintaining optimum performance and 
life for your Axiom. It provides specific information on: 

 Maintenance Procedures 

 Exterior Cleaning 

 Mounting Hardware Checks 

 Wiring Connection Checks 

 

Table 6-1: Tools and Materials Required 
Item Description 

Soft-bristle brush  For cleaning the Axiom’s exterior 

Clean soft cloths For cleaning the Axiom’s exterior 

Mild detergent solution for cleaning the Axiom’s exterior. Cleaning solutions 

70% denatured alcohol, 30% de-ionized water solution for 
cleaning exit window 

Soft cotton swabs 
or lint-free cloth 

Use to clean Axiom reader’s exit window 
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Maintenance Tasks 

Perform the maintenance tasks on an “as needed” basis to assure proper 
operation of the Axiom. Task schedule frequency depends upon the application 
environment conditions. It only requires a few minutes to complete each 
maintenance task. 
 

Exterior Cleaning 
 WARNING: Shut down the Axiom before performing this maintenance task. 

Do not stare into the Axiom’s exit window at the laser light. Avoid direct eye 
exposure. The laser light level does not constitute a health hazard, however 
staring at the laser light for prolonged periods could result in eye damage. 

 CAUTION: Do not use any chemical on the Axiom that is unsafe for plastics, 
such as benzene, acetone, or similar products. Before performing this 
maintenance task, be sure to shutdown the Axiom. 

 

The exterior cleaning procedure may be performed without removing the 
reader from the mounting structure. 

1. Turn off the Axiom. 

2. Clean the exterior (except the exit window) with a clean, soft-bristle brush. 
Be sure not to brush any dust, dirt, or debris onto the exit window. 

3. Carefully remove any debris in or around the exit window. 

4. Wipe the exterior (except the exit window) with a clean, soft cloth 
dampened slightly with a mild detergent solution. 

5. The exit window should be cleaned after this task is completed. 

 



AXIOM™ 400 Product Manual Maintenance 6-3 
  

06-AXIOM400-Maintenance_R10.doc Accu-Sort Systems, inc. 

Cleaning the Exit Window 
 WARNING: Shut down the Axiom before performing this maintenance task. 

Do not stare into the Axiom’s exit window at the laser light. Avoid direct eye 
exposure. The laser light level does not constitute a health hazard, however 
staring at the laser light for prolonged periods could result in eye damage. 

 CAUTION: Never apply cleaning solution directly to the exit window. Always 
apply the solution to a cloth, and then the cloth to the window. Do not use 
any chemical on the Axiom that is unsafe for plastics, such as benzene, 
acetone, or similar products. 

 

The exit window cleaning procedure may be performed without removing the 
reader from the mounting structure if it is possible to do so. 

1. Turn off the Axiom. 

2. Follow the exterior cleaning procedure before cleaning the exit window 

3. Check the exit window surface for any dust, dirt, or smudges. If the 
window needs to be cleaned, proceed to Step 4. 

4. Make a solution of seven parts denatured alcohol and three parts water. 

5. Apply the cleaning solution to a cotton swab or lint-free cloth. 

6. Apply the cleaning solution to the exit window. 

7. Remove any streaks or remaining moisture from the exit window with a 
dry, soft, lint-free cloth or lens paper. 

8. Verify Axiom reader operation. Follow the Operations Checklist procedure 
in Chapter 5. 
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Cleaning the Trigger Photoeye 
If your application uses the photoeye option as a hardware trigger, be sure to 
clean the photoeye periodically as outlined below. 

1. Turn off the product transport. 

2. Turn off the Axiom reader(s). 

3. Clean the photoeye’s lens using the denatured alcohol solution and a 
cotton swab or lens paper. 

4. Check the reflector on the opposite side of the transport. Clean as 
necessary. 

5. Verify photoeye operation. Follow the procedure on page 6-7. 
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Cleaning the Tachometer 
If your application uses the tachometer option for tracking purposes, be sure to 
clean the tachometer wheels periodically as outlined below. 

1. Turn off the product transport. 

2. Turn off the Axiom reader(s). 

3. Using a clean, soft cloth, wipe the wheels of the tachometer clean using a 
mild detergent solution. 

4. Before restarting the system, be sure the tachometer is making good 
contact with the product transport.  

5. Verify tachometer operation. Follow the procedure on page 6-7. 
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Tighten Mounting Hardware  

1. Check all Axiom reader mounting hardware.  Tighten as necessary. Do not 
over-tighten. Be sure not to disturb the reader’s alignment as it relates to 
the product transport. 

2. Check the mounting hardware of the photoeye and tachometer (if these 
options are being used). Tighten as necessary. Do not over-tighten. 

 

Checking Wiring Base Connections 

All wiring connections to the Axiom are made through the wiring base. Specific 
wiring instructions are located on the insulation flap inside the wiring base. 
(Reference Chapter 3, Installation.) 

1. Check all wiring connections to the wiring base terminal blocks. Tighten as 
necessary. Do not over-tighten. 

2. Check all cabling/conduit for signs of wear/damage. Repair/replace any 
damaged cable connections as necessary. 
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Verify Reader Operation 

Follow the Operations Checklist procedure defined in Chapter 5.   

If the Axiom parameters were changed to read bar codes other than the factory 
defaults, simply use a good quality bar code to assist in verifying proper 
operations. There is no need to return the reader to the default parameters to 
perform this test. 

 

Verify Photoeye Operation 

1. Block the photoeye beam to confirm it is aligned properly with the 
reflector.  

2. If the LED on the photoeye changes status, the photoeye is functioning 
properly.  

3. Verify that the Trigger LED on Axiom is green when photoeye beam is 
blocked. 

4. If the photoeye’s LED does not change status, adjust the photoeye so that 
it is properly aligned with the reflector.  

5. If the Trigger LED on the Axiom is not green when the photoeye’s beam is 
blocked, check the cabling between the photoeye and Axiom wiring base 
for damage.  

 

Verify Tachometer Operation 

There are two ways to verify tachometer operations. 

 
Use Axcess Setup Software 

1.   Connect Axiom to a PC. 

1. Start the Axcess setup software. 

2. Go to Diagnostics > Axiom Monitor. 

3. Verify the Belt Speed is accurate when the conveyor is running. 

 
Use Tach LED in Wiring Base 

1. Remove the scan head from the wiring base. 

2. Slowly spin the tachometer wheel while verifying the tach LED in the 
wiring base is flashing. 
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7 Troubleshooting 
 

This chapter provides instructions for diagnosing, troubleshooting and 
correcting Axiom performance issues. It provides specific information on: 

 Test Mode 

 Indicators 

 Diagnostics 

 Troubleshooting (Problem/Cause/Solution) 

 

Test Mode 

In test mode, the Axiom displays the read rate on the Axiom control panel’s 
bargraph LEDs. The Axcess Diagnostics > Axiom Monitor window also 
provides a read quality bargraph that enables you to monitor the test mode 
remotely from a PC connected to your network. Additional details can be 
obtained by monitoring from this diagnostic window while the reader is in test 
mode. 

When test mode is selected, either by using the control panel button or Axcess 
software, it will “time out” after three minutes. 

 

Status Indicators 

The Axiom provides several status indicators that you can use to 
troubleshooting performance during operations. They are found at two 
locations: 

 Axiom Control Panel  

 Axcess Diagnostics > Axiom Monitor screen 
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Axiom Control Panel Indicators 

 
Figure 7-1 Axiom Control Panel (on scan head)  
 
Table 7-1: Axiom Control Panel LED Fault Detect Descriptions 
Ref. LED Description 

 1  Status RED indicates a problem regarding the overall "health" of 
the reader.  
 

 2  Trigger Indicates the trigger input.  

The LED is controlled through software no matter the 
trigger source (including software trigger).  
 

 3  Read RED identifies a No Read condition. 

Check bar code print quality, trigger configuration, and 
bar code parameters. 
 

 4  RX/TX If bar codes are being read, but the LED is NOT 
illuminated, data is not being transmitted on serial port 1.
  

 5  Network   (See Table 7-2 for Network LED – Fault Detection.) 
 

 6  Link If the LED is not flashing, there is no network connection.
  

 7  Bar Graph 

(LED 1 – 5) 

Read quality indicator (5 = Good, 1 = Poor).  

5 = 81-100% 
4 = 61-80% 
3 = 41-60% 
2 = 21-40% 
1 = 00-20% 

NOTE: Also flashes during parameter upload/backup. 
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Table 7-2: Network LED – Fault Detection Only 
Mode Description 
Single TCP/IP LED is Off – No host connection or UDP messaging is used. 

NOTE: If UDP messaging is used (unconnected messages) the 
Network LED will be off. 

EtherNet/IP Flashing GREEN – No connection made with the network 
Flashing RED – Lost network connection 

Controller/Client Controller 
Flashing RED – All the client(s) with the same group number 
have NOT been found or a client’s tracking does not match the 
controller. 

Client 
Off – Not connected to a controller with the same group 
number. Match the client to the controller’s group number. 
Solid RED – Client’s tracking does not match the controller. 

NOTE: The mode indicated by the Network LED is dependent on the Axiom 
configuration you are using.  Ethernet/IP is the highest priority, Single TCP/IP mode 
operation is the lowest. 
NOTE: Reference Figure 5-2 for Network LED during Normal Operations. 

 
 
 
Table 7-3: Control Panel Buttons – Uses during Troubleshooting/Service 

Ref. Button Description 

 A  Upload to Axiom Use to upload a backup set of parameters from the 
wiring base to a replacement scan head.  
NOTE: This only works if the Backup to Base button 
has been used earlier to assure the correct parameters 
are stored in the wiring base. 

 B  Backup to Base When it becomes necessary to replace a scan head, be 
sure to use this button to download a backup set of 
parameters from the scan head to the wiring base. By 
doing this, it is easy to configure your replacement 
scan head by using the Upload to Axiom button. 

 C  Test /Diagnostic Enables the Axiom test mode.  

(Test mode can also be selected remotely using Axcess 
Tools > Axiom Commands > Test Mode On.) 

 

 NOTE: Keep in mind that the buttons on the Axiom’s control panel can be 
enabled/disabled through the use of the Axcess setup software. (For details, 
reference the Axcess Software Manual, Modify > Axiom Configuration in 
Chapter 4.) 
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Wiring Base Status Indicator LEDs 

 
Figure 7-2: Wiring Base Status LED Locations 
 

Table 7-4: Wiring Base Status LED Descriptions 

Status 
LEDs 

Location / Definition 

Polarity Near input power TB.  Also referred to as Power LED. 
RED if power polarity is reversed.  
GREEN if power polarity is correct.  
OFF indicates no power.  
DO NOT install the Axiom scan head if this LED is RED.   
 

Tach On outside edge of circuit board, behind scan head connector. 
If tachometer wheel is slowly rotated, the Tach LED will flash 
GREEN.  
(See Verify Tachometer Operation procedure in Chapter 6.)  
 

Trigger On outside edge of circuit board, behind scan head connector. 
When the trigger photoeye is blocked, the Trigger LED will light 
GREEN.  
(See Verify Photoeye Operation procedure in Chapter 6.)  
 

 
 

 

Polarity LED Tach LED Trigger LED
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Diagnostics 

Axcess for Axiom Diagnostics 
Axcess includes comprehensive diagnostic capabilities that monitor Axiom 
reader operation, triggering, conveyor speed, bar code readability, scan rates 
and message output. These vital statistics display on a single Axiom Monitor 
screen. The Axiom Monitor screen is the primary tool you will use to monitor 
the reader's operation and bar code readability in real-time, enabling you to 
efficiently detect and troubleshoot any problems that may occur in your 
scanning application.  
 

 
Figure 7-3: Axcess Diagnostics > Axiom Monitor 

Table 7-5: Axiom Monitor Screen Descriptions 
Screen Segment Description 
Status LEDs These LEDs reflect the same conditions as those on the Axiom control 

panel, as well as some additional LEDs (Match and I/O LEDs). 
Read Quality Provides information regarding the bar code that was read. 
Box Information Availability of information is based on the type of tracking used. 

Information is updated when a trigger occurs. 
Messages View diagnostic messages from the reader.  This is primarily 

information on each bar code read.  Right-click this area for clearing, 
starting, stopping and logging options. 

Message 
Monitor 

View messages being sent from any of the reader’s host ports (either 
serial or network).  Right-click this area for clearing, starting, 
stopping and logging options.

 USEFUL TIP: If EtherNet/IP communications are being used, message monitoring for 
Net Host #1 is not available.  Reference the Axcess Software Manual, Chapter 6. 



7-6 Troubleshooting AXIOM™ 400 Product Manual 
 

Accu-Sort Systems, inc. 07-AXIOM400-Troubleshooting_R10.doc 

 

Troubleshooting 

The following PCS (problem/cause/solution) tables are designed to assist you in 
troubleshooting the more common events that may occur during installation 
and operation of your Axiom Bar Code Scanning Solution.  
 

Table 7-6: PCS Troubleshooting   

Problem The POLARITY LED in the wiring base is RED. 
Cause(s) Wiring from the power supply to the INPUT POWER terminal 

block is incorrectly wired. 
Solution(s) IMPORTANT: DO NOT install the scan head if polarity LED is RED.  

1. Correct the polarity problem by swapping the wires at the 
INPUT POWER terminal block.  

2. Confirm power polarity is correct (GREEN LED).  
3. Install the scan head. (See page 3-16.) 

 
Problem There is no laser light exiting from the Axiom when power 

is activated. 
Cause(s) No power is provided to the Axiom. 

Solution(s) 1. Check to ensure power is properly connected. 
2. Check to see if Axiom Status LED turns ON. 
3. Confirm power supply functioning. 
4. Remove Axiom scan head from wiring base. 
5. Verify Power LED in wiring base is GREEN. (See Figure 7-2.) 
6. If Power LED is RED, polarity is swapped. 
7. If Power LED is OFF, check wiring at the INPUT POWER 

terminal block.  
8. Replace the power supply if wiring was correct.  
9. Reassemble Axiom scan head to wiring base. 

 
Problem The Axiom is not reading bar codes. 
Cause(s) Code type is not enabled or wrong code length. 

Code passes by at too large an angle (tilt, pitch, skew). 
All codes have very poor print quality. 

Solution(s) 1. Enable code type or correct code length. 
2. Make sure Axiom laser beam is ON when code passes by. 
3. Verify correct bar code parameters are enabled. 
4. Enable TEST MODE. (Use either the Axiom control panel 

button or Axcess Tools > Axiom Commands > Test Mode On.) 
5. Hold code in the scan line.  
6. Verify the Axiom is reading the code. 
7. Correct any tilt, pitch, or skew problems. 
8. Remedy bar code printing problems. 
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Table 7-6: PCS Troubleshooting  (continued) 

Problem The Axiom is experiencing poor read rate. 
Cause(s) Poorly printed bar codes. 

Scan head window is dirty.  
Codes passing by at too large an angle (tilt, pitch, skew). 

Solution(s) 1. Confirm the quality of bar code printing is good enough to 
read. Correct any print quality issues. 

2. Clean scan head window as defined on page 6-3.  
3. Check reading distance with a known good quality sample 

bar code. 
4. Enable TEST MODE. (Use either the Axiom control panel 

button or Axcess Tools > Axiom Commands > Test Mode On.) 
5. Hold code in the scan line.  
6. Verify the Axiom is reading the code. 
7. Correct any tilt, pitch, or skew problems. 

 
Problem The Axiom is experiencing poor read rate in hardware 

trigger. 
Cause(s) Photoeye is not adjusted properly or requires alignment. 

Solution(s) 1. Verify that the photoeye is blocked the entire time the 
Axiom’s laser is scanning the bar code.  

2. Adjust the photoeye as necessary.  
(See Verify Photoeye Operation in Chapter 6.) 
NOTE: For non-tracking applications only. 

 
Problem HOST is not receiving serial host message. 
Cause(s) Improper wiring between host and reader. 

Incorrect configuration settings. 
Solution(s) 1. Is the Axiom’s RX/TX LED flashing GREEN? 

2. If yes, check the serial cable wiring at the wiring base’s 
SERIAL COM terminal block and at the HOST. 

3. If no, verify Axiom trigger input and trigger configuration. 
4. View the Message Monitor to verify the Axiom is 

transmitting data from the SERIAL COM port.  
(Reference the Axcess Software Manual, Chapter 6 for details 
on the Diagnostics > Axiom Monitor.) 

 
Problem Axiom reads bar codes, but transmits a NO READ message. 

(Tracking Applications Only) 
Cause(s) Improper tracking configuration 

Solution(s) 1. Check for “Code Lost” messages using Axcess diagnostics. 
2. If “Code Lost” messages are present, check the tracking 

configuration.  (Reference Axcess Software Manual, Tracking.) 
3. Correct as needed. 

 
Problem Cannot connect configuration PC running Axcess to the 

Axiom’s Ethernet port. 
Cause(s) Improperly configured Ethernet port on configuration PC 

Solution(s) 1. Verify network port configuration on PC.  
2. Port on PC must be configured for a static IP address. 
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8 Service 
 

There are a limited number of field-replaceable components that are part of 
the Axiom 400 Bar Code Scanning Solution. In most cases, it is recommended 
that the component be replaced with a matching recommended spare part 
(RSP). These field-replaceable units (FRUs) are: 

 Scan Head 

 Wiring Base 

 I/O Module 

 Power Supply 

 Photoeye 

 Tachometer 

The part numbers for these items are provided in Appendix A, Accessories and 
Options. 

 

Replacement Procedures 

 

 

CAUTION: This symbol indicates you are about to perform an action 
involving, either a dangerous level of voltage, or to warn against an action 
that could result in damage to devices or electrical shock. Please follow 
necessary procedures as outlined in Chapter 2, Safety.  

 

 

 

ESD CAUTION: This symbol identifies a procedure that requires you take 
measures to prevent Electrostatic Discharge (ESD) e.g., use an ESD wrist strap. 
Circuit boards are most at risk. Please follow ESD procedures as outlined in 
Chapter 2, Safety.  
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Replacing a Scan Head 

 

 

IMPORTANT:  If you are installing more than one scan head on a network, 
install each scan head one at time and set/change the IP address before 
installing the next scan head. 

1. Save configuration parameters from scan head to wiring base or disk. 

2. Loosen the four (4) screws that secure the scan head to the wiring base. 

3. Pull the scan head straight up from the wiring base.  When replacing a 
scan head, it is not necessary to disconnect the power. 

4. Install the replacement scan head by aligning the connector on the scan 
head with the connector on the wiring base and pressing the scan head 
down firmly. In applications that are using more than one scan head 
option, be sure to install the correct scan head by confirming the part 
number. (See Chapter 3, Installing a Scan Head.) 

5. Tighten the four screws that secure the scan head to the wiring base.  

6. Set a (unique) IP address for the reader using the Axcess configuration 
software. The initial default address is defined in Appendix B. 

7. Download the correct reader configuration to the scan head. This can be 
done in one of three ways:  

 If the parameters from the previous scan head have been saved to the 
wiring base, you can use the appropriate Toolbar button to restore 
them. (Reference Axcess Software Manual. See Chapter 4, Restore 
Axiom Parameters from Wiring Base.)  

 Download a parameter set you have saved to disk directly through the 
Axiom Configuration Port Connector using Axcess and the setup cable. 
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Replacing a Wiring Base 

1. Remove power from Axiom.  

2. Unplug power supply from source. 

3. Remove the scan head from wiring base. 

4. Disconnect all cabling from wiring base terminal blocks. 

5. Remove wiring base from UMB/mounting structure. 

6. Install wiring base replacement to UMB/mounting structure. 

7. Re-connect all wiring to terminal blocks in replacement wiring base. 

8. Check power polarity (LED in wiring base). 

9. Optional, if used: Check photoeye operation (LED in wiring base). 

10. Optional, if used: Check tachometer operation (LED in wiring base). 

11. Install the scan head to wiring base. 

12. Follow procedure in Chapter 5 to confirm operation. 

13. Optional: Backup scan head parameters to wiring base. This assures the 
parameters are available if the scan head ever needs to be replaced. 
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Replacing an I/O Module 

1. Remove power from Axiom.  

2. Disconnect any other power sources connected to the I/O terminal blocks. 

3. Remove the scan head from wiring base. 

4. Remove I/O module from wiring base. 

5. Install replacement I/O module to correct location on wiring base. 
(Reference the parts list in Appendix A.) 

6. Secure I/O module to wiring base. 

7. Install the scan head to wiring base. 

8. Test operation of device connected to the I/O module. 
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Replacing a Power Supply 

1. Remove power from Axiom.  

2. Unplug power supply from source. 

3. Remove the scan head from wiring base. 

4. Disconnect power supply wiring from INPUT POWER terminal blocks. 

5. Mount replacement power supply in same location as faulty unit. 

6. Install replacement power supply wiring through correct conduit opening. 

7. Connect wiring to INPUT POWER terminal blocks. 

8. Confirm power polarity (LED in wiring base). 

9. Install the scan head to wiring base. 
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Replacing a Trigger Photoeye 

1. Remove power from Axiom.  

2. Remove the scan head from wiring base. 

3. Disconnect photoeye wiring from Trigger terminal blocks. 

4. Mount replacement photoeye in same location as faulty photoeye. 

5. Install replacement photoeye wiring through correct conduit opening. 

6. Connect wiring to Trigger terminal blocks. 

7. Confirm photoeye operation (LED in wiring base). 

8. Install the scan head to wiring base. 
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Replacing A Tachometer 

1. Remove power from Axiom.  

2. Remove the scan head from wiring base. 

3. Disconnect tachometer wiring from TACH terminal blocks. 

4. Mount replacement tachometer in same location as faulty tachometer. 

5. Install replacement tachometer wiring through correct conduit opening. 

6. Connect wiring to TACH terminal blocks. 

7. Confirm tachometer operation (LED in wiring base). 

8. Install the scan head to wiring base. 
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A Specifications 
This appendix provides detailed specifications for the Axiom 400. It provides specific 
information on: 

 Characteristics 

 Options and Accessories 

 Dimensions  

 Certifications 

 

Technical Specifications 
Axiom 400 

Characteristic Description 
Name/Part Number Visible Laser Bar Code Reader, Axiom 400 

Reference options/part numbers on Options and Accessories table in this appendix. 
Dimensions L 6.23” [158.14 mm] x W 10.87” [276.22 mm] x H 5.19” [131.83 mm] 
Weight 10 lbs. [0.66 kg] 
Temperature Operating: 0° to +50° C (+32° F to +122° F) 

Storage: -20° to +70° C (-4° to +158° F) 
Relative Humidity 10-90% non-condensing 
Enclosure Powdered-Coated Cast Aluminum, Rated for IP 65 
Power Requirements Input: 12-30 VDC, Typ. 1.0A@24VDC (Axiom only), Max. 5.0A@12VDC  

Output: Max. 2.5A Load 
Power Consumption < 40 W 
Laser Type Visible laser diode <5.0 mW peak at 630-700 nM (standard)  

Class 3R Laser Product (IEC-60825-1, 1993+A1: 1997+A2: 2001),  
Class II Laser Product (21CFR1040) 

Depth of Field 15-72” max.  See read charts in Appendix B. 
Scan Rate 700 SPS (1 video channel, laser pairs alternate) 

700 SPS (2 video channels, laser pairs alternate) 
1400 SPS (2 video channels, lasers always on) 

Bar Code Types All standard 1D symbologies including: I 2 of 5, Code 128, Code 39, Code 93, 
Codabar, Codabar NSS, UPC/EAN 

Visual Indicators LEDs – Status, Trigger, Read, RX/TX, Network, Link, and Read Quality (LEDs 1-5) 
Connections Dedicated Setup Port: requires Axcess Setup Programming Cable 

Terminal Blocks for : Input Power, Output Power, Trigger Input, Tachometer Input, 
and Communications (Ethernet, Serial, 4 I/O relays) 

Communications Standard: On-board EtherNet/IP, Ethernet TCP/IP,  
                Serial RS-232, RS-422, and 4 programmable I/O relays 
Optional: DeviceNet, ProfiBus 

Software Axiom Scanning and Decoding Software with DRX (Data Reconstruction) 
Axcess Setup Software for Axiom (Windows-compatible) 

Options 6 Axiom Scan Head Versions – (3) Standard, (3) High-density 
X-scanning bracket (supports 2 Axiom and power supply) 
120 VAC or 240 VAC Power Supply 
See the Options and Accessories table in this appendix. 

Warranty 1-year limited, part and labor; available Blue Ribbon Extended Service Plan (BRES) 
Service Options Installation assistance and training available from Accu-Sort.  
Compliance UL, cUL, FCC (Class A), CE (See Compliance table in this appendix.) 

Note: Accu-Sort reserves the right to change product specifications without notice. 
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Power Supplies for Axiom 
Characteristic Description 
Name/Part Number Axiom Power Supply (24V versions) 
Dimensions L 6.73” [171 mm] x W 4.76” [121 mm] x H 2.16” [55 mm] 
Weight 3.0 lbs. [1.4 kg] 
Temperature Operating: 0° to +50° C (+32° F to +122° F) 

Storage: -20° to +70° C (-4° to +158° F) 
Relative Humidity 10-90% non-condensing 
Enclosure Powdered-Coated Cast Aluminum, Rated for IP65 
Power Requirements Input: 90-264 VAC / 0.2A typical, 1.0A max. @ 120 VAC 

Output: Max. 2.5A Load 
Power Consumption < 40 W 
Connections Male IEC 
Compliance pending   (See Compliance table in this appendix.) 

Note: Accu-Sort reserves the right to change product specifications without notice. 
 

Characteristic Description 
Name/Part Number Dual Axiom Power Supply for use with XMB (X-Pattern Mounting Bracket) 
Dimensions L 8.76” [222 mm] x W 5.76” [146 mm] x H 2.18” [55 mm] 
Weight 4.0 lbs. [1.8 kg] 
Temperature Operating: 0° to +50° C (+32° F to +122° F) 

Storage: -20° to +70° C (-4° to +158° F) 
Relative Humidity 10-90% non-condensing 
Enclosure Powdered-Coated Cast Aluminum, Rated for IP65 
Power Requirements 90-264 VAC / 0.5A typical, 2.5A max. @ 120 VAC 
Power Consumption < 110 W   
Connections Male IEC 
Compliance pending   (See Compliance table in this appendix.) 

Note: Accu-Sort reserves the right to change product specifications without notice. 
 

Output Modules 
Part Number 1000056136 1000056137 
Nominal Line Voltage -- 120 VAC 
Maximum Line Voltage 60 VDC 140 VAC 
Minimum Line Voltage 3.0 VDC 12 VAC 
Maximum Peak Off State Voltage 60 VDC 400 V peak 
Maximum Peak Off State Leakage 1.0 mA 2.5 mA RMS 
Static off–state dv/dt -- 200 V/usec 
Maximum On–State Current 0.5 A DC 0.5 A RMS 
Minimum On–State Current 10 mA DC 50mA RMS 
Maximum 1 Cycle Surge -- 4 A peak 
Maximum 1 Second Surge 1.5 A DC -- 
Peak On–State Voltage 1.5 V DC 1.6 V peak 

Input Modules 
Part Number 1000056135 * 

Maximum Input Voltage 32 VDC 
Minimum Input Voltage 3.3 VDC 
Input Resistance 1 k ohm 
Maximum Input Current  32mA DC@ 32 VDC 

Drop Out Current 1.0 mA DC 
Allowable Off–State Input Current 1.0 mA DC 
Allowable Off–State Input Voltage 2.0 VDC 

* Note: Compatible with TTL level voltages. 
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Options and Accessories 
 

Part Number Description 

Axiom Scan Head Options 

Scan Head PN Minimum Bar Depth of Field Scans Per Second 

1000052800 15 mil + 15-72” DOF 500-700 SPS 

1000052801 10 mil + 16-42” DOF 500-700 SPS 

1000052802 15 mil + 22-58” DOF 500-700 SPS 

1000052803 10 mil + 22-35” DOF 500-700 SPS 

1000052804 15 mil + 30-72” DOF 1100-1400 SPS 

1000052805 10 mil + 26-42” DOF 1100-1400 SPS 

Axiom Wiring Base Options 

0104636001 Axiom Wiring Base (U.S. Version) 

0104636002 Axiom Wiring Base (Metric Version) 

Axiom Accessories (PTO 1000052806)  

1000007308 Programming Cable, 8 ft., use for setup using Axcess software  

1000059304 Ethernet 5-Port Switch (Linksys) 

1000051873 Ethernet 8-Port Dual Speed Switch (10/100) 

1000051570 Ethernet Cable, 10 ft. CAT5-RJ45M to RJ-45M cross-over gray network 

1000051571 Ethernet Cable, 20 ft. CAT5-RJ45M to RJ-45M cross-over blue network 

0105307002 Axiom Universal Mounting Bracket Kit (UMB) with power supply mounting plate 

0106226002 Dual-Axiom X-Pattern Mounting Kit (XMB) with power supply mounting plate 

1000020569 Photoeye Kit (flying leads) 

1000019875 Tachometer (8-30 VDC) with 20’ cable (flying leads) 

1000020567 Tachometer Mounting Kit (General Mounting) 

1000020568 Tachometer Mounting Kit (Extrusion Mounting) 

0105365001 120 VAC Power Supply 40W/24V (U.S. Version) 

0105365002 240 VAC Power Supply 40W/24V (Export Version) 

0105914001 Power Supply for Dual-Axiom used in X-Scanning 110W (NEMA 5-15P) (U.S. Version) 

0105914002 Power Supply for Dual-Axiom used in X-Scanning 110W (Male IEC) (Export Version) 

1000056135 DC Input Module (3.3 – 32 VDC, White) 

1000056136 DC Output Module (3 – 60 VDC, Red) 

1000056137 AC Output Module (12 – 42 VAC, Black) 

0106318001 Blower Assembly (120 V) – Use in bottom read application to keep scan window clean 

0106318002 Blower Assembly (230 V) – Use in bottom read application to keep scan window clean 

1000059400 AXIOM 400 Bar Code Reader Documentation CD 

1000055015 AXIOM 400 Bar Code Reader Manual (bound hardcopy) 

1000057488 Axcess Installation Software and Documentation CD 

1000057289 Axcess Software Manual (bound hardcopy) 

 



A-4 Specifications AXIOM™ 400 Product Manual 
 

Accu-Sort Systems, inc. A1-AXIOM400-Specifications_R10.doc 

Dimensions 
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XMB Dimensions 

The following illustration provides additional dimensional references for applications that 
utilize the dual-Axiom X-Pattern Mounting Bracket (XMB, PN 0106226002) as part of the 
mounting structure.  
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Certifications 
 

UL Listing

 

 
UL Listed 
 
 
UL Listed to Canadian safety standards 

 
FCC  47 CFR, Part 15, subpart B, 
“Unintentional Radiators” 

 
CLASS A Radiated Emissions and CLASS B Conducted Emissions 
 
 

 
CE 

 
Standards to which conformity is declared:  
 
1   EN60950: Test Spec: IEC 60950 3RD Edition / (2000)  (Information 
Technology Equipment (I.T.E.), Including Electrical Business Equipment 
 
2   EN 55022:1998 (CISPR 22:1997/A1:2000) Information Technology 
Equipment (I.T.E.) CLASS A Radiated Emissions and CLASS B Conducted 
Emissions 
FCC  47 CFR, Part 15, subpart B, “Unintentional Radiators”:  CLASS A 
Radiated Emissions and CLASS B Conducted Emissions 
 
3   EN 61000-6-2: 1999, Electromagnetic Compatibility - Generic 
Standards - Immunity for industrial environments. 
(Test Spec EN 61000-4-2:1995, "Electromagnetic compatibility (EMC), 
Electrostatic discharge immunity test") 
 
EN 61000-4-3: 1995, "(EMC), Part 4 -Section 3: Radiated, radio-frequency 
electromagnetic field test"  
 
ENV 50204: 1995, "(EMC), Radiated, Electromagnetic Field From Digital 
Radio Telephones-Immunity Test" 
 
EN 61000-4-4:1995, "(EMC), Electrical fast transient/burst immunity test" 
 
EN 61000-4-5:1995, "(EMC), Part 4 -Section 5 Surge immunity test" 
 
EN 61000-4-6:1996, "(EMC), Part 4 -Section 6 Immunity to conducted 
disturbances, induced by radio-frequencies  
 
IEC 61000-4-11: 1994, "(EMC), Part 4 -Section 11 Voltage dips, short 
interruptions & variations immunity  
 
IEC 61000-3-2 A14, 3/2000 and 61000-3-3: Harmonic current emissions 
Fluctuating and Steady State Harmonics) 
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B Read Charts 
 

AXIOM 400 Scan Rate Explained  

The AXIOM 400 scan head can be configured with either one or two modules. 

Each module has the option of having one or two lasers installed, but each 
module only ever has one mirror wheel and one receiving sensor. 

When two lasers are installed in one module, they share the same mirror wheel 
and sensor. In order to do this, they alternate on and off, and each laser uses 
every other mirror facet. (Reference the read charts. This configuration refers to 
part numbers 1000052800, 1000052801, 1000052802, and 1000052803.) 

The Axiom maximum scan rate when two lasers are installed in one module is 
700 scans per second (SPS). The standard scan rate is 550 SPS. The read charts 
are applicable to the standard SPS only. 

When one laser is installed in each module, that laser has exclusive use of the 
mirror wheel and receiving sensor. The one laser is on all the time and uses 
every facet of the mirror wheel. (Reference the read charts. This configuration 
refers to part numbers 1000052804 and 1000052805.) 

The Axiom maximum scan rate when one laser is installed per module is 1,400 
SPS. The standard scan rate is 1,100 SPS. The read charts are applicable to 
standard SPS only. 

The scan rate is not additive. When you have two modules in the Axiom each 
with one laser (as in the case of part number 1000052804 and 1000052805) 
each laser is reading over a different zone and the scan rate in that zone is still 
1,400 SPS or 1,100 SPS. 
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C Glossary 
 
ACK 
A control character sent to acknowledge that a transmission block has 
been received. 
 
address 
A unique designation for the location of data or the identity of a smart 
device; allows each device on a single communications line to respond to 
its own message. 
 
AEL (Accessible Emission Limit) 
The average power limitations of electronic radiation from a laser light 
source as defined by the CDRH. 
 
AIM 
Automatic Identification Manufacturers, Inc. 
 
alignment 
The position of a scanning or detection device in relation to the target 
scanning area or receiving element. Both the reader and photoeye require 
proper alignment to assure optimal performance. 
 
alphanumeric 
Consisting of letters, numbers, and symbols. 
 
ambient light 
The lighting conditions in the scanning area. Ambient light can interfere 
with successful scanning of bar codes. 
 
ANSI (American National Standards Institute) 
The principle standards development group in the U.S. A non-profit, non-
governmental group supported by over 1000 trade organizations, 
professional societies, and companies. Member body to the ISO 
(International Standards Organization). 
 
aperture 
Term used on the required CDRH warning labels to describe the laser exit 
window. 
 
application 
A use to which something is put, or how it is used. 
 
ASCII (American Standard Code for Information Interchange) 
Pronounced as-kee. A standard seven bit plus parity code, representing 
256 characters, established by ANSI to achieve compatibility between data 
services. 
 
aspect ratio 
The ratio of height to width of a bar code symbol. A code twice as high as 
wide would have an aspect ratio of 2; a code twice as wide as high would 
have an aspect ratio of ½ or 0.5. 
 
asynchronous transmission 
Transmission in which the time intervals between transmitted characters 
may be of unequal length. Transmission is controlled by start and stop bits 
at the beginning and end of each character. 
 
autodiscrimination (autodistinguish) 
The ability of bar code reading equipment to recognize and correctly 
decode more than one bar code symbology and process the data without 
operator intervention. This is a prerequisite feature of linear bar code 
scanners employed in open systems. 
 
 
 

Axcess 
The Windows®-based primary user interface that provides all the necessary 
functions to set up, monitor, and diagnose the operations of an Axiom. 
 
bar 
The dark elements of a printed bar code symbol. Referred to as elements in 
2D symbologies. 
 
bar code 
An array of rectangular bars/elements and spaces arranged in a predefined 
pattern to represent elements of data referred to as characters. 
 
bar code character 
A single group of bars and spaces that represent an individual number, 
letter, or other symbol. 
 
bar code density 
The number of characters that can be represented in a linear unit of 
measure. Bar code density is often referred to in characters per inch (CPI). 
 
bar code label 
A label that carries a bar code and can be affixed to an article. 
 
bar code reader, reader 
A single device that performs two functions: 1. examines a printed spacial 
pattern (bar code) and then, 2. decodes the encoded data.  
 
bar code symbol 
A group of bars that represent a character or group of characters whose 
width and spacing is determined by a set of rules.  In most cases, human 
readable characters are printed below the bars. 

bar height 
The height of the shortest bar in a bar code. 
 
bar length 
The bar dimension perpendicular to the bar width. 
 
bar width 
The thickness of a bar measured from the edge closest to the symbol start 
character to the trailing edge of the same bar. 
 
baud rate 
A unit used to measure communications speed or data transfer rate; 
represents the number of discrete conditions or events per second. 
 
BCC (Block Check Character) 
Used to check transmission accuracy, a character transmitted by the 
sender after each message block and compared with a block check 
character computed by the receiver. 
 
bed width 
The width of the conveyor bed measured in inches (centimeters). 
 
belt width 
The width of the conveyor belt measured in inches. 
 
bidirectional 
A bar code symbol capable of being read successfully independent of 
scanning direction. 
 
bit (binary digit) 
The contraction of binary digit, the smallest unit of information in the 
binary system; a one or zero condition. 
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bottom read 
When the scanner is mounted under the conveyor to read codes on the 
bottom of the boxes or on the front or back of the boxes. If used there is 
not enough clearance for a standard front or back read. 
 
BPS (Bits Per Second) 
Unit of data transmission rate. See baud rate. 
 
bridge 
An interface between links in a communication network that routes 
messages from one link to another when a station on one link addresses a 
message to a station on another link. 

buffer 
A temporary storage device used to compensate for a difference in data 
rate and data flow between two devices (typically M). 
 
bus 
An internal pathway along which electronic signals travel between the 
components of an electronic device. 
 
button 
A graphic user interface that allows users to select a given software 
function. Instead of physically pressing a button, the user simply clicks on 
the desired button to access a menu, tab screen, or function. 
 
button menu 
A graphic user interface that offers several buttons. The Axcess Main 
Window Toolbar offers a menu of buttons that include Save, Retrieve, 
Backup, Restore, and Default functions. Instead of physically pressing a 
button, the user simply clicks on the desired button to access a menu, tab 
screen, or function. 
 
byte 
A binary element string functioning as a unit, usually shorter than a 
computer “word”. Eight-bit bytes are most common. Also called a 
“character”. 
 
CART, See Trigger 
 
CDRH (Center for Devices and Radiological Health) 
This organization (a service of the Food and Drug Administration) is 
responsible for the safety regulations governing acceptable limitations on 
electronic radiation from laser devices. Accu-Sort is in compliance with 
the CDRH regulations. 
 
character 
A single group of bars and spaces in a code that represent an individual 
number, letter, punctuation mark or other graphic element. Used as part of 
the organization, control, or representation of data. 
 
character self-checking 
The feature that allows a bar code reader to determine if a scanned group 
of elements is a valid symbol character.  If a symbology is described as 
character self-checking, a single printed defect (edge error) in any symbol 
character does not produce a valid character. 

character set 
Those characters available for encodation in a particular automatic 
identification technology. 

check character 
A character (usually at the end of the code) that is used to perform a 
mathematical check to ensure the accuracy of a scan of the bar code. 
 
Codabar 
For details, see Symbologies 
 

Code 128 
For details, see Symbologies 
 
Code 39 
For details, see Symbologies 
 
Code 93 
For details, see Symbologies 
 
code length 
The length of the bar code measured from the start of the first bar to the 
end of last bar. 
 
code orientation 
The relationship of the bar code with reference to the scan head’s reading 
zone. Typical code orientations are Ladder and Picket Fence. 
 
code placement 
Variation in code placement affects the ability of a scanner to read a code. 
The terms Tilt, Pitch, and Skew deal with the angular variations of code 
placement in the X, Y and Z axes. Variations in code placement affect the 
pulse width and therefore the decoding of the code. Pulse width is defined 
as a change from the leading edge of a bar or space to the trailing edge of 
a bar or space over time. Pulse width is also referred to as a transition. Tilt, 
pitch, and skew impact the pulse width of the code. 
 

 
Changes to this code presentation cause the bar codes to appear smaller 
to the scanner which results in a smaller pulse width. Each of these 
variation has a different effect on a scanner reading these codes and the 
combination of the variations leads to more complicated effects. 
 
code quality 
The number of scans successfully decoded during a read cycle. 
 
code set 
The specific assignment of data characters to symbol characters. 

communications protocol 
The rules governing exchange of information between devices connected 
together on the same communications line. 
 
configuration 
The arrangement and interconnection of hardware components within a 
system, and the hardware (switch and jumper) and software selections 
that determine the operating characteristics of the system. 

configuration file 
A set of attributes that belongs to and defines the operation of a single 
physical device. 

constant tach 
Use for belt speed timing instead of using a tachometer. Axiom systems 
can be setup to generate a belt speed automatically for applications where 
belt speed does not vary more than 5%. This is generated when the 
function is selected from the Axcess  Modify > Tracking window. 

continuous code 
A bar code symbology where all spaces within the symbol are parts of the 
characters (Interleaved 2 of 5).  There is no interactive gap in a continuous 
bar code symbology. 
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continuous trigger 
This form of trigger requires no input signal. The reader is continuously 
attempting to decode bar codes. When a reader is in “continuous trigger”, 
there is no way of determining if there is a package present or a NO-READ 

conveyor speed 
The speed that the conveyor is moving measured in feet per minute. 
Conveyor speed directly impacts the time that the code is in front of the 
reader; therefore, it affects the number of reads that are possible.  
Scanning systems require consistent conveyor speeds to assure accuracy. 
 
CPI 
Characters per inch.  See density. 
 
CR (Carriage Return) 
An ASCII or EBCDIC control character that moves the cursor or print 
mechanism to the left margin. 
 
CRC (Cyclic Redundancy Check) 
A CRC is generated by treating a message as a single, large binary number 
and dividing it by a specific number and keeping the remainder, which 
becomes the CRC.  
 
CTS (Clear to Send) 
The Modem interface signal that indicates to the DTE device to begin 
transmission. 
 
data verification 
There are three data verification options available when defining the host 
message via Axcess: None, BCC, and CRC. (See Modify/ Communications.) 
 
decode 
The process of translating a bar code into data characters using a specific 
set of rules for each symbology. 

decoder 
As part of a bar code reading system, the electronic package that receives 
the signals from the reader, performs the algorithm to interpret the signals 
into meaningful data and provides the interface to other devices. 

decoder logic 
The electronic package that receives signals from the scan head, interprets 
the signals into useful data, and provides the interface to other devices. 
 
default(s) 
Original parameters as programmed by Accu-Sort at the factory. Axcess 
can be used to review the default settings and modify them, when 
necessary. 
 
delimiter between codes 
The separator used between multiple bar codes decoded and transmitted 
to the host in the same message. The delimiter is set in Axcess. (See 
Modify / Communications.) 
 
depth of field (DOF) 
The distance between the maximum and minimum plane in which a 
symbol can be read. This range is from the specified optical throw to the 
far reading distance. 
 
density 
The number of data characters that can be represented in a linear unit of 
measure.  Bar code density is often expressed in characters per inch (CPI). 

diagnostics 
Refers to the various features of the Axcess software that enable a trained 
and qualified technician to monitor and troubleshoot the operation of an 
Axiom reader. 
 
 

discrete code 
A bar code or symbol where the space between characters, intercharacter 
gap, are not part of the code as with Code 39.  See continuous code. 
 
downloading 
The process of sending configuration parameters, operating software or 
related data from a central source to remote stations. 
 
drop-down menu 
A graphical user interface that allows the user to select from a list of 
options that is displayed when a specific function has been selected. This 
options list “drops down” from the selected function. A list of drop-down 
menus can be found across the top of the Axcess Main Window. 
 
DSR (Data Set Ready) 
An RS232 modem interface control signal which indicates that the 
terminal is ready for transmission. 
 
DSR (Data Terminal Ready) 
Modem interface signal which alerts the modem that the DTE device is 
ready for transmission. 
 
duplex transmission 
See full duplex and half duplex. 
 
EAN 
European Article Number System.  The international standard bar code for 
retail food packages. 

EDI (Electronic Data Interchange) 
A method by which data is electronically transmitted from one point to 
another. 
 
EIA-232 
Interface between data terminal equipment and data communication 
equipment employing serial binary data interchange. 
 
EIA-422 
Electrical characteristics of balanced-voltage digital interface circuits. 
 
EIA-485 
The recommended standard of the Electronic Industry Association that 
specifies the electrical characters of generators and receivers for use in 
balanced digital multipoint systems. 
 
element 
Dimensionally the narrowest width in a character – bar or space. 
 
element width 
The thickness of an element measured from the edge closest to the symbol 
start character to the trailing edge of the same element. 

emitter/receiver pair 
An emitter sends a light beam to a receiver that detects when the beam 
from the emitter is interrupted. Typically used in applications where tape 
or lamination on an object on the transport could mimic the reflector used 
in a retroreflective pair. Can be used as a TRIGGER. 
 
encoded area 
The total linear dimension consisting of all the characters of a code 
pattern, including start and stop characters and data. 

ENQ (Enquiry) 
A transmission control character used as a request for a response from a 
remote station. (^E) 
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ESC (Escape) 
A control character which is used to provide additional control functions. 
It alters the meaning of a limited number of continuously following bit 
combinations. (^[) 
 
error 
A discrepancy between a computed, observed or measured value or 
condition and the true, specified or theoretically correct value or 
condition. 

ETX (End of Text) 
A transmission control character that terminates a text. 
 
even parity 
A data verification method in which each character must have an even 
number of on bits. 
 
far distance 
The distance (in inches) from the face of the scanner to the farthest point 
at which a code can be successfully scanned. 
 
feet per minute (FPM) 
Typically used to define the speed of a conveyor. Conveyor speed may also 
be defined in meters per second. 
 
flying lead 
A lead that exits the back of the connector hood on the outside of the 
cable jacket. It is normally attached to the drain wire or shield and 
connected to the chassis of the switch, modem, etc. It can also be a 
hardware control lead. 
 
front read 
The scanner is mounted to read bar codes on the leading edge of a box as 
it passes the scanner. In a front read application, the scanner can be 
mounted above or on the side of the conveyor. 
 
front/top read 
The camera is mounted to read the front and top of packages as they pass 
through the scanning area. In a front/top read application, the camera is 
usually mounted above the conveyor positioned at a 45 degree angle to 
enable it to scan both the front and top of packages 
 
full duplex (FDX) 
Simultaneous, two-way, independent transmission in both directions. 
 
gateway 
A device used to connect networks using different protocols so that 
information can be passed from one system or network to the other(s). 
(See subnet mask.) 
 
gateway address 
Like all other devices on a network, the device serving as the Gateway 
must also have an IP address so that devices wishing to communicate with 
devices outside its own network can fine the Gateway which will forward 
its data. Like all other addresses, it is displayed in the “dotted-decimal” 
format. 
 
guard bars 
1) The bars at the ends and center of a UPC and EAN symbol that ensure a 
complete scan of the bar code.  2) The optional bars outside the quiet zone 
of an I 2 of 5 symbol that ensure a complete scan of the bar code. 

Half Duplex (HDX) 
Transmission in either direction, but not simultaneous. 
 
handshaking 
Exchange of predetermined signals between two devices establishing a 
connection. Usually part of a communications protocol. 

hardware trigger 
This is an electrical signal from a relay, photoeye, or proximity switch 
indicating that an object is passing by the reader. 
 
header 
A means of identifying the beginning of a message to be sent to the host. 
One example is <STX> or Start of Text. 
 
height of scan 
The maximum vertical scanning dimension of a moving beam scanner at a 
specific distance from the face of the scanner. 
 
hexadecimal 
A base-16 numbering system that uses the symbols 
0,1,2,3,4,5,6,7,8,9,A,B,C,D,E,F. 
 
host 
1) A central controlling computer in a network system.  2) Any device on a 
network system that provides a controlling function to another device on 
the network.  3) Any intelligent device for which another device is 
providing a communication interface to a network. 

hot-swappable 
The ability to change or replace an Axiom scan head from a wiring base 
without the need to disconnect the unit from its power source. 

induct photoeyes 
The cart cycle begins when the start of cart photoeye is blocked and 
continues until the cart photoeye is unblocked. Blocking the INDUCT 
photoeye causes relay decisions and data communication. For this 
placement the distance between the CART and INDUCT photoeyes must be 
less than the minimum box size plus the minimum box spacing. 
 
input/output modules, I/O modules 
OPTICALLY ISOLATED INPUT/OUTPUT MODULES. Flexible modules that 
allow the reader to control high voltage outputs that are susceptible to 
noise. Since they are isolated from each other the noise is not picked up in 
the reader. 
 
The modules come in both input and output versions. The output versions 
are controlled by a 5VDC input. The output of the modules can range from 
24VAC - 140VAC or 3VDC - 200VDC. Foreign voltage ranges are available. 
The maximum current that the modules can supply is limited by the output 
voltage and the module type. The input versions are controlled by either a 
DC or AC input ranging from 3VDC - 32VDC or 90VAC - 140VAC. Foreign 
voltage ranges are available. The output of the modules is a 5VDC level. 
The maximum current is limited by the input modules. These output 
modules are commonly used to control diverters, alarms, external relays, 
etc. The input modules can be used for photoeye inputs. 
 
intercharacter gap 
The space between two adjacent bar code characters in a discrete code. 
 
interface 
A shared boundary defined by common physical interconnection 
characteristics, signal characteristics and meanings of interchanged 
signals. 
 
interleaved bar code 
A bar code in which characters are paired together using bars to represent 
the first character and spaces to represent the second. 
 
I/O 
The abbreviation for input/output. The keyboard and a printer, are 
examples of I/O devices. I/O activity is different from computational 
activity. When a program sends a document to the printer, it is engaging 
in I/O activity; when the program sorts a list of terms, it is engaging in 
computational activity. 
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IP address (Internet Protocol Address) 
IP Address is the numeric address given to a network card which enables 
other devices on a network to find it. For readability, this number is 
displayed in “dotted-decimal” format (e.g.: 127.0.0.1) as opposed to the 
binary equivalent (e.g.: 01111111000000000000000000000001). 
 
jumper 
A wire that connects a number of pins on one end of a cable only, such as 
looping back Request to Send from Clear to Send pins 4 and 5. 
 
ladder orientation 
When the bar code’s bars are positioned horizontally on the product, 
causing them to appear as a ladder. The ends of all bars will enter the scan 
window first. 

LAN 
The acronym for local area network. A LAN system is usually confined to 
the same building or a few nearby buildings, with all equipment linked by 
wiring dedicated specifically to the LAN. 
 
laser scanner 
An optical bar code scanning device using a low energy laser light beam as 
its source of illumination. A laser scanner or scan head sends the 
information it collects to the decoder. 
 
LED (Light Emitting Diode) 
A semiconductor generally made from gallium arsenide, that can serve as 
a visible or near infrared light source when voltage is applied continuously 
or in pulses. LEDs have extremely long lifetimes when properly operated. 
 
LF (Line Feed) 
An ASCII control character that moves the cursor or print mechanism to 
the next line. (^J) 
 
linear bar codes 
Also referred to as 1D or 1-dimensional symbologies. Examples: Code 39, 
I2of5, UPC. 
 
mA 
The abbreviation for milliampere(s). 
 
match 
A condition in which decoded data matches data in the match entry. 

match entry 
An output condition in which decoded data matches and the data in a 
match entry configuration. 

memory 
A computer can contain several forms of memory, e.g., RAM, ROM, and 
video memory. The term memory is generally used to define RAM. When a 
computer has 8 MB of memory, it actually has 8 MB of RAM. 
 
memory address 
A specific location, usually expressed as a hexadecimal number, in the 
computer’s RAM. 
 
 

message 
1) A meaningful combination of alphanumeric characters that establishes 
the content and format of a report.  2) In a communication network, the 
unit of exchange at the application layer. 

message buffer 
Storage register for the temporary storage of data that allows decoding to 
continue while the host is retrieving data from the serial port. 

message buffer warning 
An output condition that occurs when the message buffer has used a 
defined amount of the message buffer. 

MHz 
The abbreviation for megahertz. 
 
microprocessor 
The primary computational chip inside the computer, referred to as the 
“brain”. The microprocessor contains an arithmetic processing unit and a 
control unit. Software written for one microprocessor must usually be 
revised to run on another microprocessor. 
 
mil 
One thousandth of an inch (0.001 inch). Bars and spaces of codes are 
commonly referred to as being a certain number of mils wide. 
 
misread 
The scanner incorrectly decodes a bar code as it passes through the scan 
zone. 
 
Modulo check digit or character 
A calculated character within a data field used for error detection.  The 
calculated character is determined by a modulus calculation on the sum or 
the weighted sum of the data field contents. 

mouse 
A pointing device that controls the movement of the cursor on a screen. 
Mouse-aware software allows the user to activate commands by clicking a 
mouse button while pointing at objects displayed on the screen. 
 
moving-beam 
Rather than using a stationary laser beam and relying on product 
movement for a single scan, a multi-facet mirror wheel and motor is used 
to ‘move’ the beam across the code several times while in motion itself. 
 
moving-beam bar code scanner 
A device that dynamically searches for a bar code symbol by sweeping a 
moving optical beam through a field of view called the scanning zone. 
Automatic bar code reader that reads codes by sweeping a moving optical 
beam through a field of view. Moving-beam scanners are usually mounted 
in a fixed position and read codes as they pass by. 
 
MTBF 
The abbreviation for mean time between failures. 
 
multidrop line 
A single communications circuit that interconnects many stations, each of 
which contains terminal devices. See EIA-485. 
 
NAK (Negative Acknowledgment) 
A control character used to indicate that the previous transmission block 
was in error and the receiver is ready to accept retransmissions. 
 
Narrow Bar (NB)/Narrow Space (NS) 
Smallest code element, bar or space, in the bar code symbol. Also known 
as the X dimension. 
 
 
 



C-6 Glossary AXIOM™ 400 Product Manual 
 

Accu-Sort Systems, inc. A3-AXIOM400-Glossary_R10.doc 

NCDRH (National Center for Devices and Radiological Health) 
This organization (a service of the Food and Drug Administration) is 
responsible for the safety regulations governing acceptable limitations on 
electronic radiation from laser devices. Accu-Sort is in compliance with 
the NCDRH regulations. 
 
near distance 
The distance (in inches) from the face of the scanner to the closest point 
at which a code can be successfully scanned. 
 
NEMA 
In order to rate the quality of an enclosure the National Electrical 
Manufacturers Association (NEMA) has developed a system for rating all 
enclosures. A partial list of the NEMA enclosures is shown below along 
with what particles it is designed to restrict. 
 
Ratings 
3 Enclosures are intended for indoor or outdoor use primarily to 

provide protection against windblown dust, rain, and sleet, and is 
undamaged by the formation of ice on the enclosure. 

4 Enclosures are intended for indoor or outdoor use primarily to 
provide protection against windblown dust and rain, splashing water, 
and hose-directed water; undamaged by the formation of ice on the 
enclosure. 

4X Enclosures are intended for indoor or outdoor use primarily to 
provide protection against corrosion windblown dust and rain, 
splashing water, and hose directed water; undamaged by the 
formation of ice on the enclosure. 

6 Enclosures are intended for use indoors or outdoors where occasional 
submersion is encountered. 

12 Enclosures are intended for indoor use primarily to provide a degree 
of protection against dust, falling dirt, and dripping non-corrosive 
liquids. 

13 Enclosures are intended for indoor use primarily to provide a degree 
of protection against dust, spraying of water, oil, non-corrosive 
coolant. 

 
net mask 
A numeric value that is used by devices to determine whether the device it 
wishes to communicate with is on the same network. If not, the data must 
be forwarded via a Gateway. May also be referred to as Subnet Mask. (See 
gateway, gateway address.) 
 
network 
A series of stations (nodes) connected by some type of communication 
medium.  A network may be made up of a single link or multiple links. 

NVC 
The acronym for non-valid code. Defines the condition that occurs when 
an object has been scanned and no bar code could be decoded. Usually, 
this indicates that either no code was on the object or the code was badly 
damaged and could not be decoded. 
 
node 
The connection point at which media access is provided. 

no-match 
An output condition in which decoded data does not match an entry in the 
match code table. 

no-read 
When the reader is unable to decode a bar code as it passes through the 
scan zone. 
 
non-read 
The absence of data at the reader output after an attempted scan due to 
no code, defective code, scanner failure or operator error. 
 

odd-parity 
A data verification method in which each character must have an odd 
number of on bits. 
 
omni-directional 
Orientation is unpredictable and can be ladder, picket fence, or any angle 
in between. A single scan line is not sufficient to scan bar codes oriented 
omnidirectionally. 
 
one-dimensional symbologies 
Also referred to as linear codes. Examples: Code 39, I2of5, and UPC are all 
1D or linear bar codes. 
 
operating range 
The sum of the scanner’s optical throw and depth-of-field. Also referred to 
as the read zone or read range. 
 
optical throw 
Measured distance from the scanner’s window to the near reading 
distance of the depth of field. Typically, this is the closest a bar code can 
be to the scanner’s window and still be properly decoded. 
 
optimum reading distance 
Typically, the center of the depth of field. 
 
orientation 
The alignment of the code’s bars and spaces to the scan head. Often 
referred to as vertical (picket fence) and horizontal (ladder). 
 
output counter 
A counter that is associated with each output condition.  The counter 
increments by 1 each time the condition occurs. 

oversquare 
Used to describe bar codes that are taller (from top to bottom of the bars) 
than they are wide (from first to last bar). 
 
package spacing 
This is the spacing between items on a conveyor. Package spacing is 
measured one of two ways: Leading edge of one box to leading edge of the 
next or trailing edge of one box to trailing edge of the next. Package 
spacing is critical to system operations. 
 
parameter 
A value or opinion that you specify to a program. A parameter is 
sometimes called a switch or an argument. All parameters for Axiom can 
be configured using the Axcess software. 
 
parameter file, PAM file 
File of Axiom parameters that can be modified via Axcess. Parameters that 
are changed using the series of Modify functions will only be saved when 
the save or backup functions are used. It is recommended that copies of 
these files be kept on the system PC or network. 
 
parameter storage module 
EEPROM (Electronically Erasable Programmable Read-Only Memory) chip 
where the parameter (PAM) file is stored in both the scan head and wiring 
base.  
 
parity bit 
A bit that is set at “0” or “1” in a character to ensure that the total number 
of 1 bits in the data field is even or odd. 
 
percent good reads 
The number of successful reads per refresh period. This is valid only when 
the refresh period is set to 0. 
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performance indicator 
A bar code decoder function that counts the number of decodes during a 
trigger period.  When the period = 0, the performance indicator provides 
the number of decodes (up to 100 attempts).  Use the performance 
indicator to provide a general indication of bar code symbol quality or 
verify proper setup of the scanner. 

peripheral device 
An internal or external device, such as a printer, a disk drive, or a keyboard, 
connected to a computer. 
 
photoeye 
Used as a presence detector (trigger) to identify objects in the bar code 
reading zone. The photoeye emits a beam and is used with a reflector to 
create a photoelectric circuit. When an object blocks the beam, breaking 
the circuit, a signal called TRIGGER is sent to the reader. (See also: 
emitter/receiver pair.) 
 
picket fence orientation 
When the bar code’s bars are positioned vertically on the product, causing 
them to appear as a picket fence. The first bar will enter the scan window 
first. 
 

 
 

pitch 
Rotation of a code pattern about the X-axis. The normal distance between 
center line or adjacent characters. 
 
polarized laser 
A specialized laser source used in high glare environments. 
 
polling 
A means of controlling devices on a multipoint line. 
 
port 
Refers to the physical connections located on the Axiom and other devices. 
The Axiom ports include: INPUT and OUTPUT POWER, TRIGGER, TACH, COM 
(serial and Ethernet), I/O (1-4). 
 
protocol 
A formal set of conventions governing the formatting and relative timing 
of message exchange between two communicating systems. 
 
Pulses Per Inch (PPI) 
Defines the number of pulses per inch of transport travel as provided by 
the tachometer. 
 
pulse width 
A change from the leading edge of a bar or space to the trailing edge of a 
bar or space over time. Pulse width is also referred to as a transition. 
 
queue 
A buffer used to hold data in order until it is used or transmitted. 
 
quiet zone 
Required distance before the first bar and after the last bar of the code 
that must be free of marks or printing. 
 
 

Radio Frequency Identification Device, RFID 
Non-optical automatic identification devices that use radio waves to 
transmit data. 
 
read-only 
A read-only file is one that you are prohibited from editing or deleting. A 
file can have read-only status if: 
 • Its read-only attribute is enabled. 
 • It resides on a physically write-protected diskette. 
 • It is located on a network in a directory to which the system 

administrator has assigned read-only rights to you. 
 
read range, read zone 
Anywhere the reader can “see” and decode bar codes. The usable length of 
the scan line throughout the depth of field (DOF) perpendicular to the DOF. 
Any codes that appear too close or too far away from the reader are 
considered outside the read zone. Also referred to as scan window. 
 
reflectance 
The amount of light returned from an illuminated surface. 
 
relative reader angle 
The mounting angle of the reader as it relates to the conveyor surface and 
direction of travel. 
 
relay 
Relays are simply electrical switches that are typically used to control 
external diverts, alarms, etc. Relay types available are FORM A and FORM 
C. FORM C type relays have both normally open and normally closed 
contacts available while FORM A type relays have only normally open 
contacts available. 
 
relay output duration 
This is the time (in seconds) after the relay is energized that it should be 
turned off. 
 
relay output delay 
The time lapse between an event and the energizing of the relay. 
 
Request To Send (RTS) 
An RS232 modem interface signal which indicates that the DTE has data 
to transmit. 
 
resolution 
The narrowest element dimension which can be distinguished by a 
particular reading device or printed with a particular device or method. 
 
response time 
The elapsed time between the generation of the last character of a 
message at a terminal and the receipt of the first character of the reply. It 
includes terminal delay and network delay. 
 
retroreflective pair 
An emitter bounces a light beam off the reflector and detects when the 
beam is broken. Often referred to as a photoeye or PE. Typically used as a 
TRIGGER. 
 
ROM 
The acronym for read-only memory. The computer contains programs 
essential to its operation in ROM. A ROM chip retains its contents even 
after you turn off your computer. 
 
RPM 
The abbreviation for revolutions per minute. 
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RS-232 
Interface between data terminal equipment and data communication 
equipment employing serial binary data interchange. 
 
RS-422 
The Electronic Industries Association standard that specifies the electrical 
characteristics of balanced voltage digital interface circuits. 
 
RS-485 
The Electronic Industries Association standard that specifies the electrical 
characters of generators and receivers for use in balanced digital 
multipoint systems. 
 
scan 
A single pass of the laser beam over the code or a portion of the code. The 
search for a bar code symbol that is to be optically recognized. 
 
scan area 
The area intended to contain a symbol, or the location of the conveyor 
that is being scanned by the reader for bar codes. 
 
scan window 
The usable length of the scanning beam that may detect the bar codes. 
The scan window is perpendicular to the depth of field (DOF). 
 
scanner 
An electronic device that optically converts printed information into 
electrical signals. These signals are sent to the decoder logic. 
 
scanner orientation (reader orientation) 
Relationship of the scan head with reference to the bar code’s location on 
products. The scan head must be set up to insure that all code bars and 
spaces are bisected at the same time. Typically, either side read or top read 
is used for picket fence or ladder code orientations. 
 
self-checking 
A bar code or symbol using a checking algorithm that can be 
independently applied to each character to guard against undetected 
errors. 
 
sensor 
A device that detects or measures something and generates a 
corresponding electrical signal to an input circuit of a controller. 

serial transmission 
The most common transmission mode; serial, information bits are sent 
sequentially on a single data channel. 
 
serial asynchronous transmission of data 
The following are common communications interfaces: RS232, RS422, 
RS485, and 20mA current loop. 
 
When data is transmitted serially from a communications port, the 
information is transferred between the two devices one data bit at a time. 
The data flow can follow one of three different communications modes: 
simplex, half duplex, or full duplex. Each character of data within the data 
flow is transported in a binary bit frame called the asynchronous data 
frame. 
 
The start bit begins each frame. A low voltage signal on the data 
communications line marks the beginning of the start bit, at which point 
the receiving device begins looking for binary zeros and ones (0’s and 
1’s).The following five to eight data bits (the number depends on the 
format used) comprise the binary character. For error detection, an 
optional parity bit can define whether the total number of zeros or ones 
was even or odd. There are five different parity selections as shown below: 
 
 

ODD 
last data bit is a logical 0 if the total number of logical 1’s in the first 
seven data bits is odd. 
 
EVEN 
last data bit is a logical 0 if the total number of logical 1’s in the first 
seven data bits is even. 
 
MARK 
last data bit is always a logical 1 (i.e.: high/mark). 
 
SPACE 
last data bit is always a logical 0 (i.e.: low/space). 
 
OFF (NONE) 
last data bit is not present. 
 
The method used to catch errors by using parity bits is as follows: When 
the transmitter frames a character, it tallies the number of 0’s and 1’s 
within the frame and attaches a parity bit. (The parity bit varies according 
to whether the total is even or odd.) The receiving end then counts the 0’s 
and 1’s and compares the total to the odd or even recorded by the parity 
bit. If a discrepancy is noticed by the receiving end, it can flag the error 
and request a retransmission of the data. 
 
A stop bit is used to signal the end of the character. (Stop bits are typically 
one or two bits in length. The slower the transmission speed, the more stop 
bits required for recognition of the end of the data frame.) 
 
In addition to the direction of data flow and the data framing, there are 
other considerations to insure uniform transmissions. Certain operating 
parameters must be followed to prevent the loss of valuable data. 
 
The first consideration is the speed of transmission, known as baud rate. 
Serial data transmission is measured in bits per second (BPS). The baud 
rate selections typically available are: 300, 1200, 2400, 4800, 9600, 19200, 
38400, 57600, and 115200. To enable two devices to interact, they must 
both be transmitting/receiving data at the same baud rate. If it is not 
possible to do this, there must be a buffer (typically additional storage 
memory) that accommodates the differences in communications speed. 
 
Many serial communications links also use a flow control system to handle 
data transmission in addition to memory buffers. 
 
X-ON/X-OFF protocol 
A common type of flow control is the X-ON/X-OFF protocol. When a 
receive buffer nears its memory capacity, the receiving device sends an 
ASCII X-OFF signal to the transmitting device, telling it to stop sending 
data. When the memory buffer has enough space to handle more data, the 
X-ON signal is sent to the transmitting device, telling it to start sending 
data again. 
 
ACK/NAK protocol 
Another common protocol is ACK/NAK protocol. When the device 
transmits a message to the host, the host responds with either an ACK 
(06H) or a NAK (15H). If the host transmits an ACK to the device, the 
device deletes its transmit message and the communication sequence is 
complete. If the host transmits a NAK, the device will retransmit. The 
device resends data a maximum of three times. Optionally this may be 
changed to 1, 2, 3, or infinite retransmits by the user. If the device receives 
a fourth NAK, it will delete the data in its transmit buffer and display 
“MAX REXMITS”. 
 
A transmitting device ignores ACK and NAK characters received during 
data transmission. If, for example, a device receives a NAK during a data 
transmission, it will not resend the data at the completion of the 
transmission. 
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The device also has a retransmit timer. This timer is activated each time 
the device transmits data to the host. If the timer runs for two seconds 
(this is also changeable) and the device does not receive an ACK or NAK 
from the host, a timeout occurs and the device retransmits its data. Each 
time the device retransmits because of a timeout, it treats the timeout the 
same as receiving a NAK from the host computer. If the device does not 
receive an ACK before the end of the fourth timeout, it will delete the data 
in its transmit buffer and display “MAX REXMITS”. The device deletes data 
in its transmit buffer and displays the error message when any 
combination of four timeouts and NAKs from the host occurs. 
 
When the device receives a message from the host, it calculates the BCC 
for the message and compares the calculated BCC to the received BCC. If 
the two values match, the device transmits an ACK, ending the 
communication. If the values do not match, the device transmits a NAK to 
the host and waits for the host to retransmit the message. The host, like 
the device, should retransmit a maximum of three times. 
 
The sequence number starts at zero (30H) and is incremented each time a 
device transmits a new message. When the sequence number reaches nine 
(39H), it wraps around to one (31H). If the sequence number skips a 
number, the receiving device knows that a message was lost. If the same 
sequence number is received on two sequential messages, the second 
message is responded to with an ACK or NAK (as appropriate) and ignored. 
 
shielding 
Protective covering that eliminates electromagnetic and radio frequency 
interference. 
 
side read 
The scanner is mounted to read the side of a box as it passes by the head. 
 
signal 
An impulse or fluctuating electrical quantity (i.e.: a voltage or current) the 
variations of which represent changes in information. 
 
skew 
Rotation about the Y-axis. Rotational deviation from correct horizontal 
and vertical orientation; may apply to single character, line or entire 
encoded item. 
 
slider bar 
A graphical user interface that enables the user to select an 
ascending/descending value for a definable parameter by clicking on the 
slider bar and then sliding (via the mouse) until the desired value is shown.  
 
software trigger 
A serial message from an external device that controls the trigger cycle. 
 
space 
The lighter elements of a bar code symbol formed by the background 
between bars. 
 
specular reflections 
A condition when the laser light is reflected back from the code’s surface 
at an angle equal, or nearly equal, to the angle of incidence of the laser 
light. This condition makes it difficult for the scan head to detect the 
differences in light variation caused by the code’s bars and spaces. 
 
spot 
The undesirable presence of an area of low reflectance in a space. start 
and stop characters 

start bit 
In asynchronous transmission, the first bit or element in each character, 
normally a space, that prepares the receiving equipment for the reception 
and registration of the character. 

 
start and end of trigger photoeyes 
The trigger cycle begins when the start of trigger photoeye is blocked and 
continues until the end of trigger photoeye is unblocked. Relay decisions 
and data communication take place after the end of triggeer photoeye is 
unbroken. 
 
stop bit 
The last bit in an asynchronous transmission, used to indicate the end of a 
character, normally a mark condition, which serves to return the line to its 
idle or rest state. 
 
STX (Start of Text) 
A transmission control character that precedes a text and is used to 
terminate a heading. (^B) 
 
symbol 
A combination of characters including start/stop and checksum characters, 
as required, that form a complete scannable bar code. 
 
symbologies 
Codabar 
Self-checking, numeric bar code encoding numbers and several characters 
(e.g.: $, -, +, ?) with a slightly higher density than Code 39. Includes two 
bar/space sizes. 
 
Code 39 
A bar code with a full alphanumeric character set, a unique start and stop 
character, and three other characters. The name is derived from its code 
structure, which is three wide elements out of a total of nine elements. 
The nine elements consist of five bars and four spaces. 
 
Code 93 
Similar to Code 39 but requires two check characters. Code 93 was 
designed to provide a higher density symbology with higher security than 
Code 39. Although code 93 is a higher density, it is not self-checking and 
therefore requires two checksums. 
 
Code 128 
A bar code symbology capable of encoding the full ASCII 128 character 
set. It encodes these characters using fewer code elements per character 
resulting in a more compact code. It features a unique start and stop 
character for bidirectional and variable length decoding, both bar and 
space character parity for character integrity, a check character for symbol 
integrity, a function character for symbol linking, and spare function 
characters for unique application definition and/or future expansion. 
 
EAN 
European Article Numbering System used in retail industry (a superset of 
UPC) used on product packaging to uniquely identify a product and 
manufacturer. 
 
Interleaved 2 of 5 (I 2of5) 
A bar code with a numeric character set with different start and stop 
characters. The name is derived from the method used to encode two 
characters. In the symbol, two characters are paired together using bars to 
represent the first character and the spaces to represent the second. This 
interleaved structure allows information to be encoded in both the bars 
and the spaces. A start character, bar and space arrangement, at one end, 
and a different stop character bar and space arrangement at the other 
end, provide for bidirectional decoding of this symbol. 
 
UPC 
Acronym for Universal Product Code.  The standard bar code type for retail 
packaging in the United States and Canada. 
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syntax 
The rules dictating how you must type a command or instruction so the 
computer will understand it. 
 
tach (tachometer) 
Hardware device used to provide conveyor speed information to the 
scanner or camera in x pulses per inch. 
 
tag 
A collection of information associated with a single variable or I/O point. 

TCP/IP 
An industry standard suite of protocols providing communications in a 
heterogeneous network environment. TCP/IP stands for Transport Control 
Protocol/Internet Protocol. 
 
two-width symbology 
A bar code symbology whose bar and spaces are characterized simply as 
wide or narrow.  Codabar, Code 39, and Interleaved 2 of 5 are examples of 
two-width symbologies. 

terminal program 
Computer software that sends, receives, and displays serial data. 
 
tilt 
Rotation around the Z axis. Used to describe the position of the bar code 
with respect to the laser scan line. 
 
tracking 
Process of keeping track of packages as they travel through the scanning 
area. Tracking can be done based on the leading edge or trailing edge of 
packages. Belt speed (as monitored via the TACH signal) and reader 
mounting also figure into the tracking process. Several methods of 
tracking are available. (See Axcess Modify > Tracking screen.) 
 
trailer 
A means of identifying the end of a message sent to the host. One example 
is <ETX> or End of Text. 
 
transmit point 
The time it takes to transmit the decoded results from the time the object 
is first sensed (by PE or light curtain) until the completion of transmission 
to the host. Transmit point is shorter (faster) for cameras because it is not 
required to accommodate a scanning pattern length. 
 
trigger 
A signal, typically provided by a photoeye or proximity switch, that informs 
the scan head of the presence of an object within its reading zone. 
Sometimes referred to as CART signal. 
 
trigger cycle 
The time during which the reader is attempting to read the bar code. 
 
two-dimensional symbologies 
More complex bar code capable of containing much larger amounts of 
data in a smaller image size because of using either a stacked or matrixed 
construction when compared to the 1D codes. Example 2D codes: 
DataMatrix, MaxiCode, and PDF417. Axiom does not read 2D codes. 
 
UCC (Uniform Code Council) 
The organization which administers the UPC and other retail standards. 
 
undersquare 
Used to describe bar codes that are longer (from the first to last bar) than 
they are high (from the top to bottom of the bars). 
 
Uniloader 
Diagnostic feature of Axcess that is used to reload reader firmware. 

 
UPC 
Acronym for Universal Product Code.  The standard bar code type for retail 
food packaging in the United States. 
 
UPS 
The abbreviation for uninterruptible power supply. A battery-powered unit 
that automatically supplies power to your computer in the event of an 
electrical failure. 
 
utility 
A program used to manage system resources including memory, disk 
drives, and printers. 
 
verifier 
A device that makes measurements of the bars, spaces, quiet zones and 
optical characteristics of a symbol to determine if the symbol meets the 
requirements of a specification or standard. 
 
visible laser diode 
A light source used in scanners to illuminate the bar code symbol.  
Generates visible red light at wavelengths between 660 and 700 nM.  
Replaced Helium-Neon tubes in most scanners because diodes are small 
and consume less power. 
 
void 
The undesirable presence of an area of high reflectance in a bar. 

 
Wide Bar (WB)/Wide Space (WS) 
Widest code element, bar or space, in the bar code symbol. 
 
wide to narrow ratio 
Dividing the size of the wide elements by the size of the narrow elements 
of a bar code yields the bar and space ratios. Bar and space ratios can 
differ. NOTE: If the narrow bar and narrow spaces are equal and the wide 
bar and wide spaces are equal then you calculate only one ratio. 
 
window (scan head, reader, or graphical user interface) 
1) The physical location on the scan head where the sensor receives 
reflected laser light from the surface of products. 2) The physical location 
on a scan head from which the laser light exits the device. Often referred 
to as the exit window. 3) A software graphical user interface that appears 
on a monitor with which the users interacts (via keyboard and/or mouse) 
to operate various user-definable functions. In Axcess, there are several 
buttons and drop-down menus available from the Main Window. 
 
word 
A unit of data which contains two bytes (16 bits). 
 
write-protected 
Read-only files are said to be write-protected. You can write-protect a 
3.5-inch diskette by sliding its write-protect tab to the open position. 
 
"X" dimension 
The dimension of the narrowest bar and narrowest space in a bar code. 
 
XON 
A control character sent by the receiving device to signal the transmitting 
device to begin sending data. 
 
XOFF 
A control character sent by the receiving device to signal the transmitting 
device to stop sending data. 
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D Interconnect Drawings 
 

AXIOM 400 Interconnect Drawings  

The interconnect drawings provided in this appendix are useful when wiring 
your AXIOM 400 for the following applications:  

 Controller/Client with Tachometer (107480) 

 Controller/Client/Client with Tachometer (107481) 

 Start/End Trigger Photoeyes (107482) 

 Stack Light with Internal Relays (107483) 
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